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1) myadregudoya

<?

§c= mysql connect("localhost","username”, "password”) ;
mysql_create_db("dbname", §c);

3N 2.3 ddansatagudoya

3y
2) MsaugIUvoYa

<2
§c= mysql_connect("lpocalho=t”, "usernames”, "password”);
mysql_drop db ("dbname", §c):

3 24 Mrdamsaugudoya

3) ﬂﬁq'ﬁ 31U El ﬁi‘lﬂ!ﬂﬁ “1%ms.mmmmmua"hum

<?
$query = "SELECT # from table name”; // wiooww * funefondousiivus;
mysql_guery ($query):
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<?

#new_dbname = "xxx"; //Sogwdoysiidosnshaso

$query = "SELECT fieldl, field2 from table name";
mysqgl_db_query(%new_dbname, $query) ;

'
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5) MIsAEAMseNdogIUToya

<?
§c= mysql_connect("localhost”, "username”, "password");

mysql close(sc);

A a A ! 3y
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6) msnateyalasfmuasmauidesns (SELECT)

<2
select * from table_name limit 0,1
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7) Mswudoya (INSERT)

<?
insert into table name (field namel, field name2) values (*5datal’, 'sdaca2’)
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1) MIeusenugudoya
<?php
$db = new PDO('mysql:host=localhost;dbname=testdb;charset=utf, 'username’, 'password');

2) M3 SELECT
<?php

$stmt = $db->query('SELECT * FROM table');
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3) N5 UPDATE

<?php
$result = $db->exec("UPDATE table SET field="value™);

4) N3 DELETE
<?php
$result = $db->exec("DELETE FROM categories WHERE name = :name");

5) 115 INSERT
<?php
$result = $db->exec("INSERT INTO table(firstname, lastname) VAULES('John', 'Doe")");
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2. Cross Site Scripting (XSS)
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2.3.3 SQL Injection

Top Attack Methods (All Entries)

Il Unknown

Il Denial of Service

I sQL Injection

Il Cross Site Scripting (XSS)

Il Brute Force

I Predictable Resource Location
Il Stolen Credentials

Il Unintentional Information Disclo...
I Banking Irojan

Il Credential/Session Prediction
Il Cross Site Request Forgery (C...
M Process Automation

M Misconfiguration

W Known Vulnerability

I DNS Hijacking

W Abuse of Functionality

Il Content Spoofing

W Administration Error

Il 0S Commanding

I Cross-site Scripting (XSS)

3o =Y

30 210 Uszanvesns Toudn 1d5unilontse $13 2013 910 builtwith.com

SQL Injection [2] ihumiisluves Tnithensangafidamansz nusogsnhlidoya

" '
o A

o =] o ey ' y @ =
dagiinu1ilugwdoyavedlisunsulszgnd somdedoyaditilss Tuml wu Fodld siwasi 7

o [

og nnwmyInsiwii uazisaziBoavestinsinsaniinnudualunisdaIna goudly niegn
haw Fallmmguannsiidladannsoudly Wdoumlashds soL Amadud e d14
dalildagrudoya back-end Tnvldilsz Tondnn honsaiazanuansaveanis sqL Tae
SQL Injection "laj"lﬁ’fﬂwﬁm'Iﬂ'iﬁﬁNaﬂiwmmwwﬁ‘muawwﬁm‘ﬁmm&uTﬂsLLﬂﬁﬂJﬁ%’u%gﬁMﬂ
wnae liindedo udaddumalugiiny dynamic SQL statements Tigudeyatotuiiudos
T8 amun (ums18a1m " fatclient " Tuaalaunssulnawun /135vne9) [36] Tusda SQL
Injection 11ngn14Tums Tauddugmdoyadadiiines udlugiudaedosmua HTMLs §
TawRa111505 JavaScript 3o 1daBY wtoTdnoufugutoyaidedld (Client Side Database)

A 3 o
iwovzylnodeya’ld
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Top 10 2013- Application Security Risks

2013 Tabla of Contents
2013 Tep 10 List Al-Injection —

" Ingﬂmhnd!-ﬂl-%ﬂmlhm“mmﬂwhhmbmm--md-wum Tha sttacker's hostie data can trick the interpreer into ecacuting
ds or accessing dats
are oftan not slioving attackers to passweords, kys, or sesion tokens, of o explok other ]
implementation faws to asume other usary’ identities.
manﬁmnwﬂmﬂuMd—-ﬂmﬂlh-wﬁmmmvﬂmu 3. X55 tha victim's browser which can hijack
user sausions, deface web stas, or redirect the user 1o malcious stes.
4

A direct object refarence occurs whan a developer expois 1 refe " cbiect, such a4 1 fie, diractory, or database key, Without an acoms control chack or other protection, ]
sttackers can manipulate thase refarences to accass unauthorized data.

fon | Good sacurty racuires having a secure configurstion defned and depicyed for the sppication, frameworks, web server, databs and pistiorm. S should be defined,
implemanted, and maintained, s dafaul ra ofen invadurs. Addianaly, sefivais should bi kept up to deie.

o it viab do nut proparly data, such *m-nwmmmmuammm»mi—nmmmm
&mMm“mmﬁmmpﬁnmnmdmu el when exchanged wih the b
mmmwmwmmmw‘mmmnnmmwmnmhmmmmw.mn"mmm |
s sccased. If raquests ars not varified, sttack, be ablato

A CSRF attack forces 8 kgged-on victim's browser o send a forged HTTP request. g th cookia and amy other cluded Informaticn, 1o 8 vuinerable web
mmmnmnmhmhmummhmmmummmnm

uﬁ“

ch rks, 8nd cthar soft almost sl mwumhmmh“mnmtmmmhh-um |
with known may defensas and enable & range of possible sttacks and Impacts.

P -

nnhdvmMw&uumhhmhmmwmmmmmumhm ‘
or use Fages.

2013 Table of Cortents
d’ @ o d‘!‘
U 211 10 Sudums Taw@AnTion il 2013 MM TABURIVEY www.owasp.org
TumsTanfde SQL Injection 4TouRmmrsavhinisunsnnserevhe Idaaslyly
T 1 ¥
wonwandurmanglitlondoyan User input parameters) Fam1iiazgnaarn sy

a ° & o &£ ' ' v oA
Fires e l¥idudsmnenihmd 11 umsaiediide SQL FaorvifugeeTnaliluiviad
hdedoyald Tdaniilusuaivzgadufiumsidio Tsunsudszonduududumanluns
asnsuediegndes migniloudhunazgndariin i sQLiignatraunylaniin unils
° - { ) ' ~ 2 e
szloaves sQL limsthaas anafie It wdumdeyandldtloudn Foildd T
= < A
ansnulasuilsg Toa SQL Iitlu Tilegrandoanis 14
Y 1 r 9/ = @ o 9 = 9/ :’/ 9 Y o 3
Ad1uru owennantueou laidesmsgAudmanuanislud g iisinien
v v
n11$100 Tav1% URL Ao '11/il: products.php2vai=100 #14 Tow@lourrda sQrL deitreld sy

W03 Val Tasmswuanaase 'OR '1' =1 ¢ URL: products.php?val=100’ OR ‘1’=‘1

ileanindida sQL Tudauvesmssamsdumdeyalugudeyadio

SELECT * FROM ProductsTbl WHERE Price <'100.00' OR 'l' ='1' ORDER BY ProductDescription;

o o

a ¥ A A a = a 1 A% w1 A vy 9
AIDNHITUIIUADAIUDITHNTI Llﬂzﬁllﬂﬂﬂﬂﬂ1ﬂﬂluﬂgﬂﬂﬂ1ﬂ :ﬂ“}fﬂ@uﬁnﬂﬂl)

.

Y] T o &

ar { = e’ _ { ‘=' d
dflavatloudoyadandn fids sQL dansildvesnsAsiazgnisBeni
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SELECT *
FROM ProductsTbl
WHERE Price <'100.00' OR '1' =1
ORDER BY ProductDescription;

msaeMemdadae OR maduiiunsvesmsadrazlimadiusTuawe tudo 1 1
A 1 ﬁqaf’umﬁﬁ"lﬁ'hmﬂjmswmwﬂmﬁﬂm’f’mﬂm:ammﬂaﬂmﬁ’mm

a 1 1 % a‘,
M31915z TowiannaoeIna SQL Injection Tanwnevargduuy &eluiiended

Towddedldinuzuazanumuewlumsassdoyanais
2.3.4 U5219NU04 SQL injection
1) Basic SQL Injection

o o .z A 44 o &
ARYULAITIINIUYO SQL Injection Aonsunin Idmdr Tsrniunfgadids

oy lHiTen 1R i f1de SQL yanilan@oudeniu pEP 191umsasnaenmaidadeues

§ o 1 é ~ o 1
szuy lao ¥or ldunz siarudaidon 1ddal
“SELECT * FROM ‘'users' WHERE username="$user’ AND password="$pass’
o & 3/ Y a Y -:%’
MNYAAIAI SQL T1dueF8 IRl
I ! S y
“ i Double Quote tHumsvanidoyanioly « » Hfu Siring
- A20nHIA MY Ao Reserve word Tumsidigusids SQL
-
- > dydnusivend nanua
a A 1 a  as - y v a A '
- maunspdulnie ldeansadin1sfio 14 < (Single Quote) ATOUAAT I vLUNTA 19
"buser’
Tududoyaindr vzogludanlsves suser uaz Spass
3 5 o & = [ ¢:1’.’
MInMNUATH Suser = admin 1Az Spass = 123 gAfdIvee SQL sziiludail

“SELECT * FROM ‘users’ WHERE username="admin’ AND password="123""

' v
o @ A

3 , < . .

FIYAATTIU SQL Engine 92 1JAUM record 1um1514 users M) username 114 admin 1A password

=1 o @ = o 2 a.a '

W 123 mindunueezdudiuiinu 18311l usemame 714 password Hoga3a udluns Toyd 1
iy T o a a T @

TowAez 1 sQL HAumeonuuiussuaue Tnediy ‘orx="x aa'111u3049 Password tiloury

=} v W o 9/ ?.r o 1 ad o w ) T 2}’
dudusinu ldgndesnad lunumaiiadsdiodede lai
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L T e it ket el T e

Be Edt Vew Higtory Bookmarks Dools Heb

¢ @ e A fk‘ I hnpmmmcmmm‘.m .ID ﬁc: Cak Gl - @ 3 G :._..:_'_'......._,A,q!‘,,,,,,,,,,_l, ‘__':?_'_l'lbj ‘.c'v o _______'!_\\'
Usemame juser’ or '1'wl UMFWMT-‘Z |
Password [rimnime Passwond m_'— 1
Sod | ook | |

[N Fonprow Disabled !Q'l
—

s S 172 )

|y - — - —_—

3UN 2.12 redrandaemsdigszuy

“SELECT * FROM ‘users’ WHERE username="’ AND password=""or’x’=x" "

[

o od A { == - f A H, < 2
HAaaWSNNAVINNIT Injection U v211/A0U statement mswmmmmu”l“u Tﬂﬂﬂmmamﬂumu

username="" AND password="" OR ‘x’=x’ : Overall
username="" AND password="" OR ‘x’="x’ : Check 1st Statement, True or False
(username="" AND password="") OR ‘x’=x’ : Check 2nd Statement, True Only

&L A A = ar 1 9/ oA o = A 1 VoA 9
FAUNOUMTINBUNY record UABY record Ud? TuFouluisnozdlussavioly) g [oulvgahe
I~ = @ g.r 1 Aad U 9 F
sziluasuaye avu lunnumadsauaz g sz yy1é
SR ) ¥ o
2) SQL Injection M9HA91NM31% Line Comment
=~ W 9 Y o cu o @ A o o &
Auanuuzmslsnunousuy (comment) Tuussinvesyafids SQL tvenumds
P (7] @ 9 3 r!a:-%J a w it 9 1] o = ] o ,,-_%‘
N ludpaniseonvdeldnousiunii drydnuein [Fuaasnousiuninee Jogaesgiuundail
@ =1 [y : 1 )
1. - 140 MysQL luiaae4d1 ud2mmA9w whitespace 0619108 1 SAU5S
2. # 191 MySQL

R A v £ ] ) Y q 3 Y
ﬂ'J'E]EJ'NLIﬂﬂﬂu’Jﬁﬂ'lﬁllﬂﬁ“ﬁﬁ"llﬂﬂm‘h'ﬂuﬂi@Nﬂlm'igﬂl]‘luﬂ']il‘Uﬂ‘b’Q'l‘Nﬁg‘]J‘]_Iﬂ?EJ

LU
H 1
= o a

2% SQL Injection LV Line comments Tavgamdan ldiflugamdudorduitethduie
SELECT * FROM ‘users’ WHERE username='$user' AND password="$pass'

3
M3 bypass WA aasni lamail

1 =] 4 y o & o 3|
lugos user I ldilu ¥o user~ (Amdreduassn) e o users yasdeznldowiiy
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SELECT * FROM "users' WHERE username='admin'-- ' AND password="
ﬁaﬁwﬁqﬁﬁﬂﬂﬁﬁ"ﬂﬁ’gmﬂ?’ﬂ;ﬂgauﬁmﬁw record 1) username §lawdmmisaadraliidow vy
v aewe lddion1s Tddeyaaaluged user 1 ' or x' = x'— @ WFI013UI550) V30 " or 'x' = 'k
v Idifly
SELECT * FROM ‘users’ WHERE username="or 'x'='x"-- ' AND password="

3) SQL Injection ‘ﬁ'!ﬁﬂmﬂmﬂ‘jﬁ Inline comment

WudnvausmsFnunouiuiluusiaveayadids soL dumideitly doenisd
osznindadnusivosnouiurioon uazissnsldai
/* This is Comments */

ﬁ'aaeiwﬁ%m'ﬂuﬁmﬁ"lﬁ?mémmpﬁ%qm nyoquaszunlumad lfauszuy d105i

SQL Injection LU Inline comment °‘§~1 bypass Wil Aiald Ty
Tusieq user Wiloudoyaifiu Touser/*
Tuaea pass Intloudoymidhu */ orx =y
yamdsaziaouiiy
SELECT * FROM ‘users’ WHERE username='admin'/*' AND password="*/ or 'x' ="'y’
%4 ﬁﬁeﬁ%‘lﬂﬁum%gaﬁﬁ username 114 admin 1%
ieanindonlundaasdufivaue madougdas or Samwsaldiduee1dgaedeu luusn
winugaiulunsdii lins ) user Alandannsarilidon lvludnilithiiuaue 18820015 1
Inline comment ﬁ'&ﬁ
Tuaio user 1flou /* Tuveq pass Witlou */ or v = 'x Fegndavznldouiiy
SELECT * FROM ‘users’ WHERE username="/*' AND password="*/ or 'x' = !

4) Union SQL Injections

dludnyazas1Fausids Union ine191un151s2uranatiuasanasnives
doyaunaf 1&ozswmsaiisld Union i Taldae wu ninduddado

SELECT header, txt FROM news
UNNAIAS Union aoRaoaziihy
SELECT header, txt FROM news UNION ALL SELECT name, pass FROM members

v o] o o 9 o i
NaﬁWﬁ“Uﬂﬂﬂ'ﬁﬂjﬁﬂ'lﬁﬂuﬂglﬂUﬂ'ﬁU'I“U@;%lﬂ%’]ﬂﬂ'ﬁ'N news LHAZA1713 members ll‘]!.']JuWﬂﬂWﬁ

VOIMTAUN
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2.3.5 aungil#ida SQL Injection

1) M3n304 (Filter) Escape Characters NHANaIA

i . @ 4 = g y T 1
311UV SQL Injection anvaziiaziinvuiotoyand19dlowid 111y 180

U U

o
@ ]

{ 4 1 g =y )
M13N704 Escape Character noufiazth s amAuyadids QL daugeaIniiidlaTone 1de s
w A o Y v = ¥ e ' ! .

1R vinstleudeyaniinis1dse Teriues Escape Characters #1199 19y single quote (")
comment (--) U< inline comment (/* */) ¢ (Escape Characters A0 @I0NYS Hi08 AUTLNILD

=Y 4 | @ ar o ¥ 1
Tsunsunoui swoiudlannumuisvesdrsnusefmundaasnvsei oz lulannumuie
Awlnd udvzilanumineludnuae ved metacharacter 151 \n Tusds printf 1 nw1Gazgn

a3 % ) 1 a @ 1 Y ) ] At T
wlannumueduldidunilaussia unu n 159 ussviare lufiuaaaog da o Ing
statement := "SELECT * FROM users WHERE name =" + userName + Q-

¥ 1 ' (] o f qu
1fin SQL Hignooniuuiiednt record 931514 usersTABINZ 9950 14 (username) ¥ Fusi

Houdn faudh usemame ASULARAITIL ot of ot v 1ddde soL ﬁf'ra"lﬂgm%’ayaﬁ'qﬁ:
SELECT * FROM users WHERE name = 'a' or 't'='t;
Fed11Rafignii 1019 1un5A3 99 00U NS Authentication Procedure frluiiminsoadeyai
Hloudrurervazdanalfifanstududnififianaia iiesarna1ves v - ¢ dlussuaue
HONINTIMI T SQL Servers S1U UM 11 MSSQL Server oy a1a 1itFon1dyad1ds SQL naw
yasdslundadonld ﬁﬂﬁ’ﬂﬁ%uﬁﬁmwai%’ﬁﬁmTwiﬁ“lumﬁ']awﬁ’ayaﬁ’ﬂymzﬁ’wia“lﬂﬁ"lﬁ’
'a';DROP TABLE users; SELECT * FROM data WHERE name LIKE '%'
Fetoyaitloudhuilaz g Tlimus userName iR IR ude sQLluvugamedsdl
SELECT * FROM users WHERE name = 'a’;DROP TABLE users; SELECT * FROM data WHERE
name LIKE '%';
Faradwife m1319 users xgnavialUeerodawaldiownanduldan Lild

2) anudananlumstivuayiiadena (Incorrect type handling)

3 =) 13 ? ) a T o = 4
SQL Injection jUuvvuiinadudiodusudoyasindldlilddmuasiiadoyad

EY

Sudnedumnzaunie lildnsnasutedmuanusuriadoya wu lusids sor shuaiia

Y] o v A o 1Y oy v ~ By 9 < W
veveyanaesmsfoduavuagiven llsunsu i ldasnaeundeyandldiloudmiiiudoya

U

o/ )

A " o i o J a 1
yiiaduavnso li Mliflidssasdaannsaladonu (@e3e) w14 dethasuy

statement := "SELECT * FROM data WHERE id =" + a_variable + ";"
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3) ¥091% UV Blind SQL Injection

=] a @ a o 9 Y vq ¥ 1A
HuueWWAITU UL NNEI T zIaAItend 1 eror W 1dMI 103100971

a 1 Cd ad 4 4 1
Hana1neg1als 4112e1n500 (syntax) wiomsdududoyaludivinefvegdoyaiuligndos
t A s da ° v oA a ' o v dAa & a o 4
( ¥oWadda S1uunedminaeawAun i wIunedTitiog) FadToudes 1915s Tomi
9 vt ° a ¢ wa A d o ¥ =
NNVOANN error inari lani IS zimgaan A esillszneuvesdoyalugudoyad

9 as dgd 1 - o [ A g/ LY v g o
ADINT IaMsvens lavatifesededunaludnymzmonigudoyass Iwasnsfusnon

]
=1

- A < = T 9o ~ Y @ Yo o a w .
MVTINTOIND rﬁwmsmu%ummz"lmmm‘u‘nmmm‘z :un%mmmuawwmwnuwg}ﬂ configure

THuant®A219 error

2.3.6 MINA SQL Injection lu pHP

a a .3 1 T o @ a 1w
Tun111 PHP n151A9 SQL Injection 1AAT191n% 03 Tndveed1delun1saadesy
o a 4 L) ¥ 1
$1udoya AoWeAFu mysql query() Tun1sad1eans e iiiosinian s mysql_query() 1111 18
1393 Escape Characters %aﬁ‘Ju=ﬁmTﬂﬂﬁ’@%uﬁmmﬁmmiﬂﬁﬂ SQL Nl Escape Characters

A9 13U < (single quote) 1A “ (double quote) (W SQL Injection A4A10819 1uumh 2.3.4 14

2.4 M3lJeanu SQL Injectionlnesmadenlaaiasasis
2.4.1 M3 Whitelist ttaz Blacklist
1) Hesiumslismanandmieme (Preventing multi-statement attacks)
Tnilalumstloatudo WeuanaliinisBenldmds soL mnndmisiidalums
%’awawﬁm?&e‘%wzi’ﬂmmsmﬂwﬁﬁﬁmmﬁuﬁﬁ’mﬂﬂuﬁayaﬁﬂamﬁwm iy My Tag
(@13 (;) 15U a’;DROP TABLE users: u@fi"?%ﬂ1‘s§%“l%’"lﬁ’tﬂﬂ1:nnumﬂ‘yﬂﬁwé"r’minf’u”lﬁmmin
Hosiuldnnnsdiru Srlumhiulimsuansnomsioes veaded19auusemame) 71850
Faensa@oumds msdeewe soL 1dwsd
SELECT * from items where username='Susername';

Y = o

] E 4
- v TawiladerdlFuludnues username (Susername) Fail

U

" or username is not null or username="'
o & {y v
M9 SQL 7 lafe
SELECT * from items where username=" or username is not null or username=";

& ady . PRIy, . 3 a
#411UNTAUUA table items i ¥03ya username is not null vilus3uaue
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2) mstesnulaen1sida single quote

#08191ude 1) Basic SQL Injection v2il03i1 14815158199 single quote pon91N
4 A ya 9 39/ ' o w ' Y v - .. .
mmﬁ%uﬂauwyam LUANITINIIA single quote “lammnmfeanummmﬂwm SQL injection
1 g I~ o A
Idodsauysel wu Srjauuumsdesve sQL Sludsil
SELECT * from items where userid=$userid;
g/ = a g 5 U < o 1 g Y T . @ 1 é’
dlulimsasndeuriiadoyaves Suserid Nasiudaauiriniy msl¥aue suserid fage 117
a A A g 9 9
asaameserodsvosianuavesdldaunna'ld

33 or userid is not null or userid=44

=

Feaznu 1ifin1s1d single quote Tudeyaiitlondin udgmdoynamsagnlondlddromda

Q[

&
u

“e

SELECT * from items where userid=33 or userid is not null or userid=44;

' '
LY A

L aad 3 @ o w A o o [ =)
wiuashafigalumsilesiuuenvinnisnsinfyda (Blacklisy (Fnuaniala
hioyanaldfudhgszuy) dmsudoyanionnel¥ifanmfawanauda AITOY IR NIZ VYA

1

[ ] ) T o 3 9 — 4 . 2’, o
gadoanii) 1wy Tudaedieil Suiludeaiinisnsinaoudrsindans suserd 15 Wudoya

1
[

o = v . A = a o v o A o 3
HAANTNYNADY (Whitelist) (SJﬂ']ﬁﬂﬁ?ﬂﬂﬂﬂ‘ﬁﬂﬂﬁl@ﬂﬂﬂﬂvﬂﬂ?Uilﬂ&’ﬁlxﬂ’ls‘l"l‘ulﬂﬂ‘ﬁﬂﬂﬂfﬂ\?ﬂlﬂﬂuﬁ

a

=h
=e

Uszinndaavasanouri Tl 14 luds sQL
2.4.2 Parameterized Statement 59 Bind Variable
o a - dd ad ¢ o & 4 yy
AUNGMANVBINMTIAA SQL Injection ADMINIIFIWNDT AT 199m e SQL 113
a a a A =l By A % ' o @ E Tew 1 A
lumulsyilaans wdrdedemaaiei i ipudeya iwesyadids sstuediumidls

)
A = 1

flowdmn (msadradasaludnyaziifeondi dynamic string building #ie dynamic SQL) 1D
o =3 = = - a 9 a =y
anuasadoniu Tsunsumaremunlaman@salyminannmiadaasannlauiin Tng
g 11 { idd & v o
manua1en nldtloudrun 13nnnudang placeholder) Wionn13f Ui s (bind variable)
' 1 yd = o i {9 o o "
udrdsmintumwiniines lfidse Ton SQL niodsniuluu Parameterized Statement
o kY { @ o & a o
M3 14 placeholder v 1dmsgndoyaIdsuanas i ludds sQL fumsEeusids SQL
s [ 2’/ Y A ) [ 9 o -] 1 4:; o
gnugnoonnnAuAniugidoulilsunsu lidesnssaaalunisnsesdoyadmsugng ez 14
o E
Fumangldau
Y] ' a a ~ o 9 o A ' w ™ ' '
FuvoyauAazrin LM isunly placeholders Taoldladsuiuana ey sndaothaay

mysql_stmt_bind param 1151 MySQL D) oci_bind by name d115V Oracle
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9 =2 LY v o | ¥ ax & ast A a A ]
m'mnmgmﬂmmmﬂmm PHP Vl']vlﬂﬂﬁ'lﬁl'fl‘ﬁ ‘H‘L!\?cl‘l-l'J'ﬁVIHEJ‘JJﬂJ'Iﬂﬂﬂﬂ’IS1‘])’LLWﬂLﬂ‘1]

QU
"

o 7 A o

mysqli #9981 Fydnualinioaunusionm < gy placeholder lumsgnAudlsna1adedida
sQL Tudaediese 11 liins 19w Smod f1de soL gnad it launiindredds
do'lalfi
Sql = "SELECT * FROM users WHERE username=""+ Username + " AND password=""+ Password
e
H1813m314 placeholder sz@on sl 1dwai
$sql = "SELECT * FROM users WHERE username=? AND password=?";
$cmd = $con->prepare($sql);
// Add parameters to SQL query
$cmd->bind_param("ss", Susername, $password);
// bind parameters as strings
$cmd->execute();
FeoFineldn il atlousnn i ldd 5o Susername taz $password AUAIRLF 9
aosdlsiivfdaduanse ("ss'vonderfiavesdands Tay vs' dausnaewiinuesduls
Susername Hag "s" AR AR ¥iAR 13 $password) Haz ludida ssql 1910 1A1917 Fauls
Susername 1102 Spassword 1nldunuiaToanuIY 2 Fafnilwardfiaosa iy FInsne
szﬂ:Lﬂumﬂﬁﬁhﬁ'ﬁm151ﬁma§¢7’;ﬁuq Taglufinisihawessand s laudananunue
wilouiludiunilivesaniawesiida SQL [59]
2.4.3 Stored Procedures
Stored Procedure [24] flD procedure yaf1ds SQL vugIntoyaiedriamungmdoya

. A @ oA o/ Y 1o g
Wou e liuonnainduiidon 1 ¥yndeyaiummsadrdadoyaldlao lisuiudouion

< 1

o = 9) o ' - J 1A
YAMTS SQL uAvzisen 19 Tauviins call procedure tazdaw1s1iimesvesmfidoanis 1unuy [1]

[ g P = o = 9/ ! g a.ré"» 3/ 9/ F
AsdUMINIEN AT UIZSon 14 procedure mmu‘lﬂuuﬂNgmmay‘mmmﬁiw procedure

a
oA 1

1 a o 1A = J !
MAIUNINOU AIULONNANTUNT oA 1FIUNTIURBIUAYD procedure LAY WISITINDS TR0 1A S
8
Y
stored procedure Hife IdifSouludunmnlasadefe msonlFanlugduvuves
a ¢ v ¥ a g ) 49 Ye o q @ ] Ay Yo Yoy
WsuiRes uazmItAvriaveyavesvoyai sy i lnsnsesdoyan Idsuanandldhnla

S v
pdnfisz@ninm uenvindugrudeyadianunsodmuadnilumsfusidaly stored
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procedures THunna i udmuudazlFnugudoyn sndrothusy towndinsuniaaise
[ 1 1 < d o @ 1
Fudoyanin stored procedures s TiansatidstoyalunstaTneaseld sadums st iy
a o o & a A A o 9 1 <
wonwawmyuawseidsnuenmiioannivua 1314 stored procedures 14 8¢19158A13 store
(] 99 s . . Y 3’4
procedure Tu'latloary SQL Injection Tavianun

2.4.4 nianm 315Uy 312 1)) (Disabling literals)

) -

Jyn1 SQL Injection vz mmnsaud lv1dd1g1udeyaiug mivayunisvaud

o3 a

~ v . ; A = 3y 1 Yy ) ]
158171 disabling literals ﬂ’t)ﬂ'liﬂj;'lu‘ljf)i&l.ﬂ%&'”luﬂkl tym“lﬂmauniug ‘]JLL‘iJ']J“lJi‘J?I'J'IlfLL'L‘I%E‘]JLL‘]JU

a

dnaviudiunilsvesgluundida sQL vzoyanammizdoyaludnuaedumy (placeholder)

o ¥ ! Ll dy.
MU AU Uiumae SQL fade il
SELECT * FROM USER WHERE NAME='Smith’
SELECT * FROM ITEMS WHERE USERID=2

1 & @

wwlildSuoygalivhanld @udeyazdadofiawaranduiiuin dafunluidsfigndes

¥y g o &
wasuiluluanyayil
SELECT * FROM USER WHERE NAME=?
SELECT * FROM ITEMS WHERE USERID=?
M3 disabling literals 9214 UTHAD 414 placeholders Tumsiousds sQL dmfunn
1 k) ]
Yoo 1d5umnnndld duiuns Tawidds SQL Injection lugihwufing 12l reduse lannsa
1 A g i o
W& Togifuilifioaun H2 database engine 11170 Ty r1inas 19914 disabling literals
] =3 d‘dy g Yt a a w =] o Y ~ ) A Y] sy
ema“liﬂmmmﬂTuiaﬂu"lu”lﬂnmmﬂfm'n'msmm“[ﬁﬂamﬁm;mﬂmyammwmmﬂmﬁum
Ay oy
ila

o

2.4.5 msmmunszauanud A lums1Fau (Security Privileges)

o
w Y

° o ) 9 a9 VAo Y 9 &2
msmnuaszauanud Ay lumslfangndeyamnsuilueyaialfidhdsdoya

g

3y
alzs.c\a( A vé’,

. . : . . :
mmeigliliansiuTinstlosnuiiugninia dniuialiniseyanalWE 190 Privilege i

a3

A y ad a:le

aunsamuvIoaumsniegutoyald odalsiaTEmstRsA TN 0 NUEE 891
M39nTauAR2Y SQL Injection "lﬁ’wh‘lj"u”himmmuﬁﬁﬂum1 SQL Injection 1@
W90 2.4.6 1A 2.4.7 uaaIsud lunwizves PHP
2.4.6 msilosnulaelilanyy mysql_real_escape_string( )
Huisdsudmsudeams ldmsnuseRsmmy nromne  Tuside SQL (e 1414

o W { @ o s ar d o
e SQL Mlasasiudmiuns query nieoravasvninmsizonldferis mysql query()
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1 <2

< #&item = “Zak's and Derick's Laptop";

3 sescaped_item = mysql_real_escape_string($item);
2>

gﬂﬁ 2.13 f0819m 3 1Fian mysql_real escape_string()

' 1
=

9INAI0813 Tafdauls sitem 1FuETinToanute single qoute (') Fuilushus simmdolns
GonldWanau mysql_real_escape_string() Llﬁ)’uﬁﬂ?’iﬂ%‘ﬁ Ay Sescaped item 3‘?} Qﬂ'Tﬁﬁ s
$escaped_item Auazdauiy

"Zak\'s and Derick's Laptop"
Tasvzinmstiuazeaning \ihwthshuse ey

Y o

fide SQL dmSuaTindeunmsaonsune

$q="SELECT * FROM member WHERE username='$username’ and password='$§password' ";

¥
wing 1 loudoyasatl :
username : admin

password : 'or'l' ='1

e sQL A1&vznaneithy -

$q="SELECT * FROM user WHERE username='admin' and password=" or'l'='1"";

Feazvir i Tandannsadiszuudenduld ins1z 91 password sznmuihy or 1 = 1 Fufhumsii
TiSouludhunse uadrldariau mysql_real_escape_string() 19121928 19714

$q="SELECT * FROM member WHERE username—'$username' and password="$password' ";
$q=mysql_real _escape string($q);

M $q sziiludil

$q="SELECT * FROM user WHFRF username='admin' and password— ‘\' or '1\' —\'1°";

M3 query 13 SQL Yavaitins1z \ 11T escape * ¥ ldA1u04 password 9t UEU v or V1

=1
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1
A

dmfuluns@iidlfidolsznoudrodasnus iy escape character 191 O'Reilly
Tuwewndindnilogiiudainig 198 1d4 mysql_real escape_string( ) gﬂ!tﬁ%ﬂﬂﬂﬂﬂﬁtﬁﬂﬁﬂﬂgﬁﬁﬂ
Judoya
2.4.7 matdeaiulaem sy Prepared Statement ’!unm%miagmi’iaymmu PDO
Prepared Statements [40] 1Huf1v05 API TunmisvhaudauduvesnisnTdsunsusy
yudoyalaonss Madon mysql query() LUVEWIZIWRIRITS SQL ﬁ’mfagaﬁéﬂ%’ﬁfﬂﬂuﬁb
wlsansannides TsewsnTaun1s TonAuuy SQL Injection 14
U@ Prepared Statement 9$419A189(Command) i1 query toniu Iagaznon Tndaiu
voaf1da 10w 1ds Aow bind query 11 TFings
3514411 Prepared Statements Tun1si¥onsofugmteyaiuy PDO
1) 7135 SELECT ¥@3/auuy Prepared Statement
<?php
$stmt = $db->prepare("SELECT * FROM table WHERE id=? AND name=?");
$stmt->execute(array($id, $name));
2) N7 INSERT 40yauuy Prepared Statement
<?php
$stmt = $db->prepare("INSERT INTO table(fieldl Jfield2.field3,field4,fields)
VALUES(:field1,:field2,:field3,:field4,:field5)"):
$stmt->execute(array(:field ' => $fieldl, "field2' => $field2, ":field3' => $field3, ":field4d' => $field4,
field5' => $fields));
3) 3 DELETE Ye3auuy Prepared Statement
<?php
$stmt = $db->prepare("DELETE FROM table WHERE id=:id");
$stmt->bindValue(':id', $id, PDO::PARAM_STR);
$stmt->execute();
4) M3 UPDATE 9@3jauul Prepared Statement
<?php
$stmt = $db->prepare("UPDATE table SET name=? WHERE id=2");

$stmt->execute(array($name, $id));



25

2.5 M3109f SQL Injection Tnel¥1sunsunsrnaevign
2.5.1. Tsunsunsreaeuldauuy Static
§lums1¥ Static Analysis Tool $Fr0lumsnsnaenIdaTie10ites T iy 1Y
AlanAannsoiiu IR SQL 1ey SQL Mnjection 1$131'18 TaudenudeaInidaqudaSunen
A Yo

a o 4 ' ' ' @ : . . o
wanduldsunsuwesamsaud lugesInd1dod19vudfl ¥4 Static Analysis Tool HETA¥1S

a

@

905 WTAE

1) Graudit

Graudit [42] 1T 1 simple shell script uagiAuisaveagluuigroTd a0 dumn
Founnioslunmssnunanmlasassiionufatyluresa1da Tnuls utility GNU grep {19115
WonTWd Configuration tazA1r199 Tun15AT 19881 Regular Expressions Y044AALAMH U014 1)
technical requirements szhﬁﬂﬁ"i,ﬂﬁuﬂsnﬁﬂmuﬁﬂmju

2) Yet Another Source Code Analyzer (YASCA)

YASCA [43] FuTdsunsulszian Temiugefafiwesnives Tnilunamaonsonas
Y1190 code quality 910 source codes 11 Talsunsn am150 141810 PHP, Java, C/ C + +, uay
JavaSeript AMTUMITAYIANNYReaNBuAzTNINN code quality

3) Pixy

Pixy [4411HuT15un 5w Java uun lifia 198 10 Aduiiumsanny 1daves pup 1ag
8aTuiid 19615 un3529a0Y cross-site scripting (XSS) taz 84119 SQL injection Y99 PHP
Taonnz

4) AppCodeScan

AppCodeScan [45]1 il uinsoailof 1Fifo aunusesa 1dad mSudun1do Ininais
puundenitaluiufie SQL Injection wwldmsiugaasaitossyiaddunazanseiiorniy
gUATIVIIN code base Lﬂ%qﬁﬂﬁ”lﬁ"lﬁizyﬁaghmwmTm' WITYNBINIT IFuvesianduuas
anefiensoir lugmaRatuvestes Tudminfu o NET Framework 3viiedomsidion

Yt

wazufludhiduseudmivdidesmsnontu cur uvaedfuiummmny
5) OWASP LAPSE+ Project
LAPSE + [46] iWuaunuueiduanulasassdmiunsasinaedosInd lasnmiz
M3 Injection voadoyadi siindodeludauTusunsun1u Java EE 39 185unswanndiunénsy

dmiuTysunsu Eclipse (www.eclipse.org) 1191MIRN1 Y Eclipse Helios 1ag Java 1.6 M30g9



26

11 LAPSE + 00115 Wau11a8 Benjamin Livshits (S U@ UN 19909 Griffin Software Security
Project

6) Microsoft Source Code Analyzer for SQL Injection

Microsoft Source Code Analyzer for SQL Injection tool [47] 1%!.‘1?11?)?1'1‘1)"%114‘3' SQL Injection
IF?WUEN Active Server Pages (ASP) Lﬂu&ﬂ%ﬂdﬁﬂﬁﬁ 5U classic ASP code ]'lln‘b" NET code gm%ﬂu
Tu VBScript

7) Microsoft Code Analysis Tool NET (CAT.NET)

CAT.NET [48] 114 binary code analysis tool lumsszydulsnalivesrosTnd Xss uag
SQL Injection 18 CAT.NET ii4! snap-in 1 Visual Studio 2005 15@ 2008 ﬁﬁzuﬂ’auﬂwémﬁ’m
anulasanynielunssams code (C #, Visual Basic. NET code, J #) L‘I’l'"llf’u

8) RIPS—A Static Source Code Analyzer for Vulnerabilities in PHP Scripts

RIPS [49] iif1uie3 o aofidonu PHP fiam1sn 95515 Static Code Analysis 1DY%04
131U PHP applications 1HutA3eailefidaemsiuidiineslumnaaeon

9) CodePro AnalytiX

CodePro Analytix [50] #101509M 191U 1880 Eclipse Tayld automated source code
analysis 10z asgoslnidnmnulanady uaziingamnsounldifoninisnsevii
orfatuInduma lldnlmons

10) Teachable Static Analysis Workbench

Teachable Static Analysis Workbench (TeSA) [51] fiD m%aﬁﬂiumima%mu 1y
mewﬁm“ﬁ'uLﬁawwimTHa'ﬁ’i'mmmﬂaﬂﬂﬁ’ﬂﬁtﬁmﬂmﬁuma%ﬁaunﬁi’ﬂauﬁmgaﬁ"[aimmzﬁu
TESA waoumsmmuannsesile lunsmises Ininamualnouaadlay data flows
TuTl991UY09 TESA dzaiudyu serviets Liag Java Server Lﬁ'lffu"lmi“lﬁﬁﬁumguiudaumau%u
HAWNWALATY

11) Fortify Source Code Analyzer

Fortify Source Code Analyzer [52] 1 Source code analyzer “ﬁﬂssmawmmzwmmnﬁm
mivealnd Idadrusseadfofivhanun dwesalda wieyaves duazitlaadi g

12) Rational AppScan Source Edition

AppScan Source Edition [53] fi® Static Analysis Tool N3 S’]J‘]I'NI‘H’J' WU reviewing data
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13) Klocwork Solo

Klocwork Solo [54] A1 Tu/sunsud1m¥1 Java Developers 3jaitfu 11/#insviani mobile 1ag
Sunowndindu Taedhaldnsuuy Eclipse 1191097 Tugin lumsaum Temalunis Tau Ty

2.52 Tsunsunsreaevulfauuy Dynamic

1
I =

1 Ao g Yy A o o & 2 o

WuTlsunsuiduiudestimsaemsnnasiuguvesszuiuuidouiiogyins

a 2 Y ] ay ada 2 o
A599a0U9T Tutuneumsasaeuiuzilummanoums lauddroms TauAiiRavuts e

{ o @ ' ' . o
seuungUuuuidlu 16 deielsunsuasieaouTAnuuYy Dynamic 51 Acunetix [55] iy

. Yo o o ¢ 4 d ad s A = ' A g o

Dynamic Tool l¥d3uminudinlud wie Guidivines monsgilvesTnilanfslusuase

T ad I'd 1
aoIviIos e 1
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2.6 Editor #1%10sm iutennadmdu
2.6.1 Netbeans
NetBeans [39] A0 13 peflodm$u Tdsunsuweifoz 19 wanuonndndudaen 1

Tava 1iu Tulsunsutszian Tomiumefadadldan lusufudeadoiuluns e wazidame
woiaIaalddaulauasiindanuniludaudas ufly awng vesTemivaedalaof Sun Micro
System flugdanivayulnsems

{19917 NetBeans 13 uanufiousnntetuuas 145 umswann I8 ianuams oy
wiseee) HennInv e lumswamennan FuRIn 18191087 Sranunsaldlumsvema
#aduq Id8nnarnnarsTasanalusunsuiey (Add-onldain Sulsdniosmamnes
(Update Center) Y89 NetBeans +% 1 0141 C/C++, Ruby, UML, SOA, Web Application Java EE
Mobility(Java ME), Java FX, Java Seript tae PHP 11 udu Tumedsu 6.0 15 udvu1din1559u
Tusunsuaiudnen fid e ludafnneues NetBeans 11 W Tnoaunsadoniaseldmonds

¥
o o J [ < o
Ts51n5u NetBeans HuaungndiueenainduiuTuga (Module) §a9i114

v H ¥ '
@1115011 Module A199 ALK ladadeidumdaduiudulunionaeld 1900187y
a as ) o A 4 )
szuulUAmMsIuIad Syna MAC OS X tag Solaris

q

2.6.2 Eclipse

=

. =] y i | 3 o o w
Eclipse dunsesieniFonn integrated development environment (IDE) 811 S UNM

applications 1614 java W30M¥10U 9 19 C/C++, Python, PERL 1A% Ruby “ad [58]

A [ v a 9} Y ar :{ kY [
Eclipse @131307095u)andu lanainnas danninldniu Java lumswanuen

A o ' 1 . s ) w . a ¥y A
WALATUUDIN TR 1IN ﬁ’]il’lﬁﬂcl‘]f Eclipse ‘Iuﬂ’liwwu"lllﬂ Iﬂﬂﬁ'«] Eclipse J@N172UIARDUN

s A

a 1 9 Y . a ¢
auysal Aedlinioalion1en 19ldmion uenvnil Eclipse aunsaldwannTusunsunsu « ¢

o v
v oA Y

o ] ] g/ ar = ot . 3 =
dildaanduiueg wu didesmariamennangu Iagldniu PHP &1 Eclipse fdnsuntn
vq 9 Y, : w o X & a . o 1
PHP 191135019 Eclipse Tun1sWaiun1¢ Belipse 1taz Yandud1a 9 voq Eclipse WAIL10Y
4 o a g -
1014 Eclipse Public License (EPL) 1o 1% Eclipse 111500121 Tvian uazfiaaa1aw wonoini

daenunsodsudyad Tuagih ludasimie'ld
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Codename Year Platform Version
Callisto 2006 32
Europa 2007 33

Ganymede 2008 3.4
Galileo 2009 3.5
Helios 2010 3.6
Indigo 2011 3.7

Juno 2012 3.8and 4.2
Kepler 2013 (planned) 4.3
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3.1 MIUATIEHIZUY

L % a 7
3.1.1 WgilszasnlumsImngsiszun

@

§ a @ = :? o g a 4
Weanininguseasandnveslassnuiiimuil deo msviTusunsuldnsuiiie

asvaoulda PHP WiiveelndnonsTanufiuuy SQL Injection ¥4 a09u1INI9AD ¥ sHaILA

[} 9 o 1

A A 4 - S S BT = P A A oA
INTDIUD (tool) “Uull’]qh‘ilf HIDUUATDINDNUBDYLUAIUINAUIND ﬁJ'lﬂﬂ“lﬁﬁﬂH']WU'J']iJlﬂﬁ'ﬂﬁﬂJ@iu

U

'
A o

mInsndeueyaelszinnuan Ao insosileNiinisnsdvaen TRAULY static (Static Analysis
=& o i 4 9y A P 3
Tool) ¥V IMIsHUAUNG DI 1A DY 1nT04lioNINITas19doun1s i uveeTisunsy
5 o q' o é 4
(Dynamic Tool) Hevz$1a09dunadenaiion i lisunsuihan Funtesielumsasivasnlda
MUY static YU PHP amnsadunldon 148 2 Tsunsufie pixy uag RIPS madSasiuden

4 1 [ 4 o
Pixy 1199910 lude e 19 3uF s vines lumsnagon Tsunsnuazamisasy Iaaudududow

3 g

u35iai IRAsuAT 1018 R ntius ohmsSnngiaasaves Pixy lumisastvaaulda
PHP Tiflusuas1uAonts Toufuuy SQL Injection Tnsns19aoufu g 20 d fs9us711
90 1800 php seripts web developer [56] tiie ldnansnaaaids Sauidingerviiiiudly
{1o99nM3FU Pixy 1TunA5uTY Text mode ifonIwazaanlunIsas 9oy Hanyidasiiang

[ 9 1
Uandu Pixy 1918 UN3 NetBeans 1108 Eclipse 1o lda1uisoiion sy Pixy U1 NetBeans 1o

4
=

Eclipse 14 #935msdandusilass
as Shah, .
3.1.2 3smsiansu Pixy a4UU NetBeans iz Eclipse

o
- msddandu Pixy a9U¥ NetBeans
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4 o
1) UUINYUI503 NetBeans 101 File > Open Project... #1351

Q . ProjectSqlin

Eclrt Vlcw Navigate Source Refactor Run Debug Prefile Team Tools Window Help

. ——— CtrleShift+N | ?‘ ‘ﬁs D B~ -

a ew File... trl+
9 NewFil CtrdsN

|lsB_Open Project... Ctrle Shift= 0
Open Recent Project

Close Project (ProjectSqlinjection) @

Close Other Projects NB'BEHHS "]E
Close All Projects
OpenfFile..,
Open Recent File

Project Groups... {
Project Properties (ProjectSglinjection) | Recent PTQjECtS

Import Project 2
f Export Project v : <no

ORACLE

L

| Save Ctrl+S A
Save As..,
Save All Ctrl+ Shift=S

Page Setup...
Print... Ctrl+ Alt+Shift«P
Print to HTML...

3UN 3.1 111199m51T08 Project L NetBeans

2) N TRLEN Open Project 1aon ProjectSqllnjection 1aana Open Project
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O N\ NNRIToRT S/

_ Lockn: |l Desktop vi ¥

! &b -

= 7] momitene

| i (& Cline | ProjectSqiinjection

| i |, demo | T "

| . 9 MyPixy Open Required Projects:
|. Ongnals

‘
? < present project
4

D@y 19 nn 57 v

% File name: e ';Jsus&;?u_-mutwm'b:*hopﬁnmﬁdwemm
Network Flesof type:  project Polder v

Open Project |

3‘ljﬁ 3.2 wihamsiden ProjectSqllnjection 114 NetBeans




3) ProjectSqlInjection ﬁ;ﬁmm%ﬂsmguuwﬁﬁm Projects Y94 NetBeans ﬁﬂgﬂ‘ﬁ 3.3

File Edit View Navigate Source Refactor Run Debug Profile 1

PEES DE

Projects X |Files | Services | -
@ & JavaApplication1
=R WProjectSallnjection

- jg Important Files
[#} ib Libraries

31U 3.3 1h1A18 ProjectSqllnjection U1 NetBeans

4) A Projects U4 NetBeans Tvidlalvld Scanner.java ﬁﬂgﬂ‘ﬁ 3.4

[Proects  Fies [sowees | |[Swtfage x|l samese X| )
———— | B eE n-ARFRIIP ek aYles
=\l Source Packages ! 15
o} Efpmrmwm |‘ 216
£ Aboutjava | PTe]
‘ a1e if(fileFath '= null)(
| 219 tzy |
- Il 220 if Mehant o ade
; Ul Lo RuntampagesRunt 1l (| dex
&l uwmtﬂu i 222 String namepath = filePath;
o L | a3
| ¢ String batFile="C:\\3QLInjectionScann
| :i 225 process = Runtime.getRuntizs().exec("
L o -y || 226
avigator x| B =y : ::: bufferRead = new BufferedReader (new Ii
Members v || <empty> | i i
(E® m::};'a_"f:"‘:tv\" et 2 | 0 while ((textscan = bufferRead.readLin
} ( Chedtype(Strng getvariable) : it | {
‘ @ Bdterss(irng origralCode) : Srrg ] 232 linepixy.add (textscan);
() Fndvariable(srng str, k) : Syng [l 293 }
§ GetsirngDeiste{5ng getiarable) 1 S5y | 234 bufferRead.close();
() GetStringlnsert(5tring getvariable) : Strng 235
 GetStingSelec(=rng gettarabe):Strrg | 23 number0fLine = linepixy.size();
© acbonPerformed(4ctionE ent &) “ 27 S R G
&0 Fepath: g ‘ 23
80 fountpto bosesn | . int foundline = 0;
Q;] msg : String ull 240

£

s o T ETE— W

gﬂﬁ 3.4 wihaauaaadlalWd Scanner.java U84 Pixy YU NetBeans
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5) luussvini 218 uaz 222 ¥04'Wd Scanner.java 1110y filepath 1WiTufiog (path) vos

' Y k] )
lWa PHP Ad09n15 eUNUIMTUNA Run | b | 30 Fe ilodal¥ Pixy vhasenin

28 ifffilePach]'= null){

29 ey {

2 ‘

2 P! 2X

Iy String namepath = m

23

24 String-bacfile="C:\\SQLIn;ect1onScannex\\pixy-nastor\eun-al) "+namepath;
2 process = Runtime,getRuntime().exec("cnd /o “shatFile); ' o0

226

21 bufferRead = new BufferedReader (new InputStreamReader (process.getInputStrean() )):
28

: H o H “
3N 3.5 A4 filePath 1T ufioguos Id PHP Aidoen 5 ALY NetBeans
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6) tiie Pixy iimsaunuiadauiosudazuansnamsaunudandmalusf 1.6 a9

sznoulidae
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2. MUY TMINNY

HNOMG Pixy HONMINTUAUFEI THIvoaldaNsuns10a0n 15 TandiuY SQL Injection ‘1éitdA

Pixy @130 duNUY0I 1MINTUATIADMS Touf1521AN Cross-site Scripting (XSS) 14@6 taly

v
a0

- 4 ' a ) . v & =S H w .
Tnssnuiiruisgaulud Iannelfiia SQL njection Miniu Faveduiiussiia SQL Analysis

Output

s A7 N\ TSN )

Total Vuln Count: 0

AR RN EEENEEE

XSS Analyses END

mrereRRRTIE R E R

sErrrsRETTETRRAEE

SQL Analysis BEGIN

E L T L )

.

Number of sinks: 1

SQL Analysis Qutput

messrmamenerem

1

- C:\Users\WaramunL encvo\Desktop\check_leginphpc7 |
. F7)

I Total Vuln Count: 1 I
FELEERREPRRE TR

L5 SOL Anaslysis END

TErERORTErR SRR b

Total Time: 2 seconds

3N 3.6 AP 1HANITAUNUYDI Pixy U NetBeans
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5 . X . o i
1) ‘IfnﬂTifT%’”N New Java Project U111 Tﬂmﬁ’ﬂﬂ File > New > Java Project ﬂﬂgﬂﬁ 3.7

File | Edit Source Refactor Navigate Search Project Run Window Hi
Lo New AusieNW(E JvaPojes 3
Open File... [ Project...

Close Ctrl+W | ff Package
Close All Ctrl+Shift+W | @& Class
Save Ctiles | @ Interface
Save As... G Enum
Save All Ctrl~Shiftss | & Annotation
o & Source Folder
45 Java Working Set

Wi 4 Folder

g Rename... F2 (5 File

o it S P\ & | Untitled Test File
Convert Line Delimiters To » Y} MUnit Test Ease
Print... Ctri+P FY Eample..
Switch Workspace ’ £ Other. ChIEN
Restart

4 Import..,

1 Export..
Properties Alt+Enter
1 edit.php [C:/AppServ/www/WebLogin/demo]
2 connectdb.php [AppServ/www/.../demo]
3 connectdb.php [AppServ/WebLogin/...) I &l Cora s

Gegaration

4 signin.php [Users/WaramunLenovoy...] -

30 3.7 wilneueaInsadIs New Java Project U1 Eclipse
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v
o

! 5 & . oy i
2) A3%0 Project 11U Pixy 9910111800 Use default location 112307 Finish Aeg19 3.8

Create a Java Project
Create 2 Java project in the workspace or in an external location,

mel Piry )
roject na Pixy
default location

Location:  CAUsers\WarsmunLenovo\workspace\Pixy- Browse...

JRE

(®) Use an execution environment JRE: ilel_SE-L._?

(") Use 2 project specific JRE: jrel
() Use default JRE (currently ‘jre7")

Project layout
() Use project folder as root for sources and class files
(® Create separate folders for sources and class files

Working sets
["] Add project to working sets

Working Zets:

Froplems @l Jd¥adoc

Jo conseles to display at this tin

¥

3 3.8 miA1amsAa¥o Eclipse Project
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¥
= 1

3) 113 disable "build automatically” 1INMY Project TnoilWTinToaninegniioy

Q

Y 3 W =
MiNUBAY A931N 3.9

Fide Edt Source Refactor Navigate Search

e P |[FRYERER U - Open Project R e gy
Clote Progect
IS Packageboplorer 12 S B T 2 M

& FieTestPy o Buid A CirieB

',d; Fresme Buld Project

& HelpTool Build Working Set »

{5 Poy Clean 4 4 &

- 7 Buid Automaticaly S nATIATaIMINE DI
e 4
- S InTadvLaan

g‘l.lﬁ 3.9 M3 disable "build automatically” 11&&1114! Project UU Eclipse



4) ABAYNN Pixy 170N Import. .. > File System 13309 Next

e (@t Sowce Mesctee Movgste Sawch Pryect Ben Wiesow My

1 Package o Geogh Wew Toollnt .
o Fatew N '
W Frame Golete
::”"‘ [ ——

o Oper “ypt Hoamechy 7]
Shew b A Shl s W

Y .
e Copy Gualded Haere

o ra oy
X Odew Drbete

L ’

Source A Shda 5
Lt A Shre To

rpen
Lot

o Rk L]
Cose Progect
Car brrelated Browcts.
Anign Woking Sety
Dibug s 0
Lo "
1iadey
Tearw "
Comvpure Pith ’
Rastern from Lecal Mstony...
Conbqre *
Prpwe aRe bty

LE

Import resources froe the local fie rystern s i ewting proect

Select n mpent source
fpe 1w e
4 & o
B Avchue Fie

S

& 05

o e

© B il

" i Mg Deveispment
&> PunTiebog

s Tam

v A

@} Back

30N 3.10 wi9euEAINIT Import Project Ul Eclipse
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5) 130N Browse... > Pixy > OK #3311 3.1

@ Import - 5“}

File system
Source must not be empty.

From directory:

BternalToolBuilders
| .settings r
4. bin
* . build
Into folder: £ . config | Browse.. ]l
T > (& doc ImY gy 2 N
@ [0 <Back | *Nets Finsh | Cancel |

3 3.1 wiweudnIn3s Import Project Pixy 11 Eclipse



43

6) Aniiag Projects Y94 Eclipse Tdalold Scanner.java ﬁdgﬂ‘ﬁ 3.12

i Package Exploer [ B "=
e Pay
FREE
£ atactumen.infosys.www,pory
£ stacuwien.infosyswww piry.analysis
{5 atactuwien.infosys v piry.anaysis.aas
5 akactumienfosys gy anayss s
£ atac.tuwien.infosys.www.pory
&} atactumien.infosys.www.piry.analysis.depen
8 atactumien.nfosys.wrw.pory.analyss depen
{1 atactuwen.infosys.www.poy.analysis degen
8 atactuwien.infosys.www.pory.2nalysis.global
{8 atactuwieninforys wwnw piryanalysisingl

St

if(filePath != null){
try {
//Tf you don't want to see a window open
/Runtine, getRuntise().exec("cnd /c start /MIN mybatch.bat”™);

String nasepath = fileath;

String batFile="C:\\SQLInjectionScanner\\pixy-saster\\run-all “snamepath;
process = Runtise.getRuntime().exec("ced /c "sbatFile);//start

bufferfead « new DufferedReader (new Input3tr easheader (process. getInputStrean()));

while ((textscan = bufferRead.readLine()) != null)
Linepixy.add(textscan);
bufferkead.close();

nusberOfLine = linepixy.size();

System, cut.println(nusterOfLine);
int foundline = 0;
String sign = "directly tainted!”;
for(int 1 = ¢; § ¢ nusberOfLine; is+)
| textscan = linepixy.get(i);
foundline = textscan, indextf (sign);

if(foundline >= 9)
nusber(ineSql.add(i);

H ' A o
3N 3.12 wihdauaaansda IWd Scanner java ¥o4 Pixy Ui Eclipse
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7 luussvinh 218 uaz 222 ¥09'1Wd Scannerjava 19105 o4 filePath 1 T ufiog

a

T y ! ]
(path) ¥4 1Wd PHP fidoem s aunu91AUnA Run o edal¥ Pixy hmsaunu

1) Scannerjava £ &
26
a7
218 if[filepath]!= null){
29 try {
220 //1f you don't want-to-see a window open
21 [ [Runtine.getRuntine().exec("end /c start /MIN mybatch.bat");
by String nanepath = filePath;
23
4 String batFile="C:\\SQLInjectionScanner\\pixy-naster\\run-all “+nanepath;
25 process = Runtine, getRuntine().exec("cad /c "thatFile);//start
26
7 bufferRead = new BufferedReaden(new InputStreanReader process. getInputStrean()));
28

UM 3.13 M3As filePath (ufieguesIvld PHP AfoamsaunuLY Eclipse
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§) toNA Run 1107 Pixy dziuaasnamsaunueenuuiundidInusagin 3.14

{.( Problems @ Javadoc (&) Declaration E Console 52
<terminated> Pixy Vulnerability Scanner for PHP [Program] C:\Users\Waramu,

EEEXEEEERERR KX KX KK

3 3 3 ok ok ok ok ok kK Kok ok

SQL Analysis BEGIN

e 3 o K o R K KK Kk Kok

Number of sinks: 1

SQL Analysis Output

____________________

directly tainted!
I- C:\Users\WaramunLenovo\workspace\Test2\check losin.php:7
- Graphs: sqll

- unconditional

ITbtal Vuln Count: 1

e 3 e e 3K i i 3 o ok e e e ok o ok

SQL Analysis END

XEEXEREXREERE R KRR

Total Time: © seconds

U 3.4 mheuEaaramsaunuea Pixy U1 Eclipse
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Ivlan volvla Mdaniivealni Tnanlauloud
$get_ref=
@mysql_query("SELECT | SELECT * FROM ‘referrals' WHERE
" FROM ‘referrals’ 1d'='$1d'
WHERE 'id*='$id"");
Supdate ref =
@mysqgl_query("UPDAT
UPDATE ‘referrals’ SET “hits'='$hits'
E ‘referrals’ SET
WHERE 'id’='$id"
“hits'='$hits' WHERE
Ad ‘id‘:l$idlfl);
1 Management\fad\ | $update cookie =
ctchrefscr.php @mysql_query("UPDAT
UPDATE ‘ref cookie' list SET
E ‘ref cookie' list SET
‘ip’='$ip' WHERE ‘id'=$id'
‘ip'='$ip' WHERE
‘1d'=$id");
$insert cookie =
@mysql_query("INSERT
INSERT INTO ‘ref cookie_list'
INTO “ref cookie_list'
("id",’ip") VALUES ('$id', $ip")
(‘id’,'ip") VALUES
(‘$id','$ip")");
mysql_query("INSERT
INTO blog SET title =
Blog\aoblogger\p | '$title’, message INSERT INTO blog SET title = '$titlc',
2
pppp.php ='$message’, time = message ='$message’, time = '$time’'

m

'$time'") or

die(mysql_error());
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T
vl

ban.php

die("Could not insert ip");

f ¥olvla mdaniiveslnd Tnanlaulaad
$createblog="INSERT into
bl_blog(author,blogtitle,thetime,realtim

mysql_query($createblog) | e,shortblurb,maincontent,allowcomment
Blog\blog\admin\
or die("Could not create s,month,year,catparent)
addarticle.php
blog"); values('$blogadmin’, $title', $thetime', $r
caltime','$short','$long','Sallow',' $Smonth'
,$year','$thecat')";
$makeanswer="INSERT into
Blog\blog\admin\ | mysql query(Smakeansw
bl_pollchoices (answer)
addchoice.php er) or die(mysql_error());
values('Spollchoice")";
News
$query = "SELECT id, username,
Publishing\aWeb | $result =
password FROM users WHERE
News\aWebNew | mysql_query($query);
username='Suser123"";
s\feedback.php
$query = "SELECT id, username,
$result =
password FROM users WHERE
News mysql query($query);
username='$user123"";
Publishing\aWeb
$queryl2 = "UPDATE users SET
News\aWebNew
$result12 = password='$ POST[passwordl]'
s\changep.php
mysql_query($queryl2); | WHERE
username='$_SESSION[Username]"";
Blog\blog\admin\ | mysql_query($insertip) or | Sinsertip="INSERT into bl banip

(banip) values ('$ip')";
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Tvlaq o lvla mdanilyealn? Taanlauloud
$query = "SELECT id, username,
$result =
password FROM users WHERE
mysql_query($query);
username='$user123"";
News $query = "INSER'T' INTO news(cid,
Publishing\aWeb category, title, author, shorta, longa,
8
News\aWebNew datetime, eauthor) VALUES
s\ post.php mysql_query($query); (‘'$_POST[cid]',$_POST[category]',$_P
OSTltitle]',$_SESSION[Username]','$
POST[shorta]','$_POST[longa]','$_POS
Tldatetime]','$ POST[eauthor]")";
$banner =
Advancelviewme | @mysql_query("SELECT | SELECT * FROM banners WHERE
9
.php * FROM banners ‘id ='$id'
WHERE 'id’='$id"");
$banner_stat =
@mysql_fetch_array(@m
SELECT * FROM stats WHERE
ysql_query("SELECT *
id'='$id'
FROM stats WHERE
Advance'\catchad | “id’='$id"™));
10
d.php $update_banner =

@mysql_query("UPDAT
E stats SET hits'='$hits' ,
“uni_hits'='$uni_hits'

WHERE id='$id");

UPDATE stats SET ‘“hits'='$hits' ,
‘uni_hits'='Suni_hits' WHERE id='$id'
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Ilad yolvla MmFantiveslna Tnanlauloud
$get_banner =
@mysql_query("SELECT | SELECT * FROM banners WHERE
* FROM banners "id"='$id'
WHERE 'id"'='$id");
$update =
@mysql_query("UPDAT
E banners SET
UPDATE banners SET ‘name’='$name'
‘name'='$name’ ,
, ‘mouseover ='$Smouse_over',
‘mouseover'='$mouse_ov
“location’='$location’, urlto’='$urlto’, st
erk
opit'='$stopit',"java_status’'='$java_statu
“location’='$location’, urlt
sbar',” openin'='$openin' WHERE
o'='$urlto’, stopit'='Sstopi
Advance\editme. id='$id'
11 t','java_status'='Sjava_stat

php

usbar', openin'='$openin’

WHERE 'id"='$id"");

$update =
@mysql_query("UPDAT
E banners SET
‘name’='$name’'
‘mouseover'='$mouse_ov
er',
‘urlto’='Surlto’, stopit'='Ss
topit', java_status'='$java
_statusbar',"openin’'='Sope

nin' WHERE "id"='$id"");

UPDATE banners SET 'name’='$name'
, mouseover'='$§mouse_over’,

‘urlto’="$urlto’, stopit'='$stopit', java_st
atus’='$java_statusbar','openin’='$openi

n' WHERE "id'—'$id'
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Wdi solvld Maiiivedni KafTaulowd

$resultf= $queryf = "SELECT * FROM stats
@mysql_query($queryf); | WHERE “id'='$id";
Supdate =
@mysql_query("UPDAT
E stats SET UPDATE stats SET
‘made’='$made’, file_loca | ‘made’='$made', file location'='$locati
tion’="$location’,'width'=' | on',"width'='$width',’ length'='Sheight',’
$width',"length'='Sheight', | hits'='Shits',"uni_hits'='$hits', views'='$
“hits’='$hits', uni_hits’='$ | views','uni_views'='$uni_views'
hits'," views'='$views',’uni | WHERE 'id’='$id'
_views'='Suni_views'
WHERE "id"='$id"");

» Advance\editme. | $update =

php

@mysql_query("UPDAT
E stats SET 'made’=
'$made’," width'='$width',’
length'='"$height', hits'='$
hits', uni_hits'='$hits', vie
ws'='$views', uni_views'
='$uni_views' WHERE
id'='$id");

UPDATE stats SET

‘made’='$made’,' width'='$width', lengt
h*='Sheight',"hits’='Shits',"uni_hits'='$hi
ts',"views'='"$views', 'uni_views'='$uni_

views' WHERE 'id'='$id'

$stat =

@mysql_fetch array(@m
ysql_query("SELECT *
FROM stats WHERE
id="$id""));

@mysql_query("SELECT * FROM
stats WHERE id='8$id"")
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Tvlan volvla maanilvealyd Taanlaulann
$banner_info =
@mysql_fetch_array(@m
@mysql_query("SELECT * FROM
ysql_query("SELECT *
‘banners WHERE 'id'='$delete'")
FROM ‘banners* WHERE
‘id'='$delete™));
$remove banner =
Advance\remove
12 @mysql_query("DELETE | DELETE FROM ‘banners' WHERE
.php
FROM ‘banners WHERE | "id'='$delete’
“id’'='$delete");
Sremove_stat =
@mysql_query("DELETE | DELETE FROM stats' WHERE
FROM 'stats’ WHERE ‘id'='$delete’
“id'='$delete');
$Query = "update banner set shown =
MySQL_Query($Query);
0 where ID = $01dShown";
Ad Management
13 \banner_ad\bann
$Query = "update banner set shown =
er_ad\ran.php MySQL_Query($Query);
1 where ID = $NewShown";
$query = "INSERT INTO “banner" (
Ad Management | $result = ‘ID", “banner’ , ‘link’ , “shown' )
\banner_ad\bann | mysql query($query); VALUES (", '$banner’, '$link’,
14

er_ad\ban_install

.php

'$shown')";

$result =

mysql_query(Squery);

$query = "delete from banner where ID

— l$IDIl‘I;
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dh olld MiFaniiven THanlaulowd

if{$action==loeschen){$lo
esche=mysql_query("DE | $loesche=mysql_query("DELETE
LETE FROM $ad_table FROM $ad_table WHERE ID=$ID");
WHERE ID=$ID");}
$stats=mysql_query("UP
DATE $ad_table SET "UPDATE $ad_table SET
IMPRESSIONS=0 IMPRESSIONS=0 WHERE ID=$ID"
WHERE ID=$ID");
$stats=mysql_query("UP
DATE $ad_table SET "UPDATE $ad_table SET KLICKS=0
KLICKS=0 WHERE WHERE ID=$ID"

Ad Management | ID=$ID");

15 \azbanner\admin\ if($action==partnernew){
stats.php $new=mysql query("INS

ERT INTO $ad_table (ID,
ART, PARTNER, CODE,
IMPRESSIONS)
VALUES
(",1,$BEZEICHNUNG,'$
CODE',0)");}

$new=mysql query("INSERT INTO
$ad_table (ID, ART, PARTNER,
CODE, IMPRESSIONS) VALUES
() /$BEZEICHNUNG','$SCODE',0)");

if($bannermodify==true){
$aendern=mysql query("
UPDATE $ad_table Set
URL ='$URL' WHERE
ID = '$ID");

$aendern=mysql_query("UPDATE
$ad_table Set URL = '$URL' WHERE
ID = '$ID");
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Ivlan ¥olvla Mmdanilveslnd Thanlaulaad
if($action==bannernew){
$new=mysql query("INS
ERT INTO §$ad_table (ID, | $new=mysql query("INSERT INTO
ART, BILD, URL, $ad_table (ID, ART, BILD, URL,
IMPRESSIONS, IMPRESSIONS, KLICKS) VALUES
KLICKS) VALUES (",0,'$BANNER', $URL',0,0)");
(",0,$BANNER','$URL',0
0)");}
$aendern=mysql_query("
$aendern=mysql_query("UPDATE
UPDATE $ad_table Set
$ad_table Set BILD = '$BILD' WHERE
BILD ='$BILD' WHERE
ID ="$ID"");
ID ="$ID");
Ad Management
if($partnermodify==true){
15 \azbanner\admin\

stats.php

$aendern=mysql query("
UPDATE $ad _table Set
PARTNER =
'$SPARTNER' WHERE ID
E4TID™);

$aendern=mysql_query("UPDATE
$ad_table Set PARTNER =

'SPARTNER' WHERE ID = '$ID");

$aendern=mysql_query("
UPDATE $ad_table Set
CODE ="$CODE'

WHERE ID = '$1D"");

$aendern=mysql_query("UPDATE
$ad_table Set CODE ='$SCODE'
WHERE ID ="'$ID'");

$abfrage=mysql_query("S
ELECT * FROM
$ad_table WHERE
ART=0 ORDER BY ID");

$abfrage=mysql_query("SELECT *
FROM $ad_table WHERE ART=0
ORDER BY ID");
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Ivlan ¥olvla Maanivedln? Tnanlauloud
$abfrage=mysql_query("S
Ad Management $abfrage=mysql_query("SELECT *
ELECT * FROM
15 \azbanner\admin\ FROM $ad_table WHERE ART=1
$ad_table WHERE
stats.php ORDER BY ID");
ART=1 ORDER BY 1D");
Squeryp2=mysql_query("
LOAD DATA LOCAL
$queryp2=mysql query("LOAD DATA
INFILE '$file' REPLACE
LOCAL INFILE '$file' REPLACE
INTO TABLE $table
INTO TABLE $table FIELDS
FIELDS TERMINATED
Affiliate TERMINATED BY ') ENCLOSED BY
BY'\ENCLOSED BY"\"
Programs\oversto \"" LINES TERMINATED BY "\n'
16 LINES TERMINATED
ck_dfs\feeds IGNORE 1 LINES");
BY 'n' IGNORE 1
\upload.php
LINES");
$mysqlresult =
mysql_query("update "update $table set
$table set mdnumber ndnumber=1000000*rand() ";
=1000000*rand() ");
$querypcatname=mysql_q
$querypcatname=mysql_query("Select
uery("Select * from
* from categories where
Affiliate categories where
id='$ GET[cat]' ");
Programs\oversto | id='$ GET[cat]' ");
k7
ck_dfs $querypl=mysql_query("
\category.php Select * from Stable $querypl=mysql query("Select * from

where

category='$catslash' ");

$table where category='Scatslash' ");
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Tlan ¥olvla Mmaaniivealnd Thanlauloud
Affiliate $queryp=mysql_query("S
$queryp=mysql_query("Select * from
Programs\oversto | elect * from $table where
17 $table where category="Scatslash' limit
ck_dfs category="$catslash' limit
$start,$num_per page");
\categoty.plip $star(,$num_per page");
Affiliate
$sgl="insert INTO admin VALUES
Programs\oversto
18 if (mysql_query($sql)) { ('1')$_POST[username]', $pass', MSCA
ck dfs
xU4Bdrc' );";
\dbsetup.php
mysql_query("UPDATE
sites SET clicks = '$row
UPDATE sites SET clicks='$row[1]',
[1]', users ='$udusers'
users='$udusers' WHERE id='$row[0]'
WHERE id='$row[0]'",
$db)or die(mysql_error());
$result = $sql = "INSERT INTO sites (id, clicks,
mysql_query($sql) or url, users) VALUES ('$id', '$clicks',
Click Tracking
die(mysqgl_error()); '$xtl', '$userid')" or die(mysql_error());
19 \counter\counter\
mysql_query("DELETE
counter.php

FROM sites WHERE
1d=$id");

DELETE FROM sites WHERE id=$id

$result =
mysql_query("SELECT
id, clicks, url, users
FROM sites WHERE
id=$id", $db) or die();

SELECT id, clicks, url, users FROM
sites WHERE 1d=$1d
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mysql_query("UPDATE
UPDATE users SET pword =
users SET pword =
Classified . md5('$newpass') WHERE email =
md5('$newpass’) WHERE

Ads\PHPRentals\ "‘Suser’

email = '$user');

20 phprentals\admin
mysql_query("UPDATE

\passwordchange UPDATE users SET pword =
users SET pword =
php md5('$newpass') WHERE email =
md5('$newpass’) WHERE
'$user’

email = '$user');

Tunrnedt 3.1 4iarh 1819 IS S unonnfmaudaunilso1n 1500 PHP scripts web
developers mega pack Tun1snAROUNIT0 117 SQL Injection Tasanmsauny IWdranua W
TRafdugesIndty farsldeds mysql_query O Fufludrdai 19 uns query Yo3a91n
gudeyalasdoyaiioglnaduly O ndsmhdaiufidassu 2 siluvude
1) fulsszianansa cﬁaﬁgﬂuuuma@uuﬁa mysql_query (A16)5); 15U
- 'mysql_query (Squery);
- $objQuery = mysql_query($strSQL);
Tagdeatinmsmmuanvesdanlsildne
2) AR5 9AIAT SQL c?}qﬁgﬂuumm%uﬁ@ mysql_query ( #1844 SQL ); 151,
- $banner = @mysql_query("SELECT * FROM banners WHERE ‘id'='$id' );
- mysql_query("DROP TABLE $table ads;"); udu
HeNIING mysql_query @13150 191870 Fds sprintf Tmﬁgﬂuunﬁ'ﬁﬁ
$sql = sprintf("DELETE from 'user' WHERE 'user id' ='%s' ",
$_POST['user id']);

Tagi %s unudaulsansa §_POST 'user id']
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r ] 3 1
dudlvhilfiAagecTnainidideil IdestlostunisTondtsznn sqL Injection #na1IW1a2 14
usi Pixy TiausodunuIng PP 714 DO 18 iy ludmvesmsaunuuazidly Ida i wy
1 1 " <1 J o
¥04117 uteeeniy 2 daundn
' Yo &
1) msud luludauvesns 19mas mysql query
2) msud lulugauves PDO
3.1.5 YO UIUAVRITZUY
1) M3auny
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3.2 N1IYINUUUSZUU
3.2.1 Use Case voa1))sunsuilandu

o 1 < 1 A
ﬂ']‘i“Vl'I\‘l'IMﬁJENT‘]J‘iLLﬂ‘ElJLL‘]JQﬂﬂﬂlﬂu 3 auUne
Id‘ o

1) dunu’lild PHP on1roa Inifivh1¥iAn SQL Injection

2) uflvidanTdeIniltasady
3) 9 Help oy 19 1da1umsudaiinn auma uaz35loariy SQL Injection

Scan

et —

-"\_\_
= 1

A 1 Code 13l iJ’E]:i‘“>

f

l"‘-\ e
Y & |l

7 Help )
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Parameterized Statement 130 Bind Variable

MUNANANYOIN5AA SQL Injection AonsfiiuiFiiinesndrayn
s squ iy Hludnlsalinoniudhdarenmed il g udoya
Senwoayards viuogiuitgleouwdun (msndraneialudnyas
ffidedenn dynamic string building Y39 dynamic SQL) tilon111anasiy
amnlsunsimarenyavdn@sadymiifannnssdaraiay e
wiin Taemsiffuaiane q ﬁli'liﬂumiﬁuﬂfﬂﬁlﬁui’umn (placeholder)
vionn 1@ anls (vind variavle) dasisanififiummiiines Tuis: Ton
SQL H‘iﬂﬂfﬁ’ﬂf’i’u'lumu Parameterized Statement

314 placeholder i1l deyad Idsunadlylusids squ
fumsidisuida sQL grusnosnvndudetudifou sunsihidesnss
Analumsnsosdoyadmiunng sriter Idsumnendldam

gudoyaunazyiia v:iin15iTon1d placeholders Tagld
WarfFulunna ey snd2081919U mysql st bind, param Gy
MySQL ¥38 oci_bind_by_name §1%51 Oracle

31 4.12 nhae Help: msiloaiuTas1d Parameterized Statement
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3.2) 35m351e3/U SQL Injection Tasmsunluigudoya
51135 3iloeiu SQL Injection Tnemsimuaszduanudidylunisld

£ " Ao o
NuHTIYamnI iy

Security Privileges
msfmuaszdunmdidyluns iFaugmdoyamiisutiv
oygabiidhfedoyammziiddiang dusimstloatuiugniinis
Aaiudelunaseyg a TS privitege ATeunsaiity 3o auarsa
wiogndoyald ev1alsf@Tinsil Moasransoanaudomeen
M359n1oAd 0 SQL Injection ‘M’m’ufu‘lu’muwnnﬂﬂqm SQL Injection
18

31 4.13 111199 Help: m3tlosiulanld Security Privileges
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3.3) nmsilesin SQL Injection Tagl¥ Stored Procedures

o511675M51e9riu SQL Injection Ta14 Stored procedures

Stored Procedures

Stored Procedure [24] 1B procedure %AMHa SQL vugdoya o]
ﬁmuumﬂnqaﬁau‘l’ﬁﬁ‘lﬁuuﬂﬂﬁmi’uﬂﬁm'li'jmﬂaqaﬁummm
hiladioyaldTaelisniiudosdougadida sqL s uszifon1dlao
113 call procedure LAz AW 1TIABTVBARITIRBINTs Trimu [1] darfunas
fluonndmduveionls procedure mail 8dumegudoyan:deandas
procedure (MATIAANNDY duonnansuiidenlfaunsuifsuase
procedure LA W13 1IABT AR DTy

gﬂﬁ 4.14 vivhao Help: mstlesiulasly Stored Procedures
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3.4) 35m31eaiu SQL Injection Taen13111 Whitelist 110z Blacklist

951183515309/ SQL Injection Tned)oefunsvi Whitelist 11az Blacklist

13411 Whitelist 18z Blacklist
Tunstieadutlszianilannsousanengoy &y

1) Hoaduna Wsirdauinn S milasticfa (Preventing mult-statement attacks)
Finilalumstlosrudelioygaliinnionidids sor innnm

niladdalunsfosvonilenfadenstioansars Towiihnsituddea

'1ﬂ1u170qaﬂﬂamﬁ'1m wun1siiy Teody © 1'11'11 a;DROP TABLE users;

un"i‘imiﬁezlﬂﬁmw1:n1mmm[ﬂfi'nfqm"lﬁu‘lu'mmmi’laqfi"uﬁ’

nonsdiel Sluminiud nrurassenniteves vesdeldin

(usemarme) 1 185U Feomnsedeumids nsdoeve sqL daail

SELECT * from items where usemame='Susername';

31N 4.15 nrhe Help: msileadulasn1svh Whitelist 1o Blacklist
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3.5) 35msile st SQL Injection Tnsan@nmsl¥auiasnusiialy

8511675n15809AU SQL Injection TnssmEnnis 1faumsnusial

snidnmslfaudidnunialyl Disabling lirerals)

ﬂtym SQL Injection v~mmmuﬁ‘lu'lﬁ'ﬂwpm‘fuqaﬁu*} miuryu
M9 NAG NN disabling literals fonsfigrudoyavs lafoyaald
ﬂnua'!u;ﬂuuui’am‘mlla.;ﬂuuuﬁmmﬂumunﬁwmsﬂuuum:h
SQL 11-aqagmmmziuua'luﬁnumvﬁ"nmu (placeholdes) i1y Aarfu
sunuudda sqL mﬁu'hlﬂ

SELECT * FROM USER WHERE NAME='Smith'
SELECT * FROM ITEMS WHERE USERID=2

v liflduoygpaliontd @ridoyaszdafofianarnnduuim
daiugluuuedaiigndesssAoath ludnwois

SELECT * FROM USER WHERE NAME=?
SELECT * FROM ITEMS WHERE USERID=?

31 4.16 nhee Help: mstlosiulagenidnmsldaudasnysialy
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w o @ i d 2 o~ 4 3 @
dimun1diinsnaaeuTusunsuTasnaaeudungy' s PHP §eiinmsidoudony

£ ' a v A w 4 =
Pudoyauuy MysoL FudunguWddsadunldlumsnadensu pixy Tuund 3 was 1WSH

Wonstanugmudoyaluy PDO

4.3.1 Taanimswenaenugiudoyauuy MySQL

4 o a o w " o 1 o
itieev1n Tsunsulandulimnimadnives Pixy viWade S9vnisnadeoy

anugndosvos TsunsuTanih hinaasudu IWdnguiderruildnaen pixy Tuumit 3 S

g’a A 4 1 @ é ~
navua 20 Idaniimsieudedugiudeyauny MysQL Fanafildanmsnaaeunasnis

Wigumeuny Pixy 731 lddanrs1edi 4.1

M319n 4.1 Wsuifivuwamsaunuued T sunsulandusy pixy

Y| =
' ' el : NaansiNainay
Ilad ¥olvla mFaniivealnd 3
N Pixy
$get_ref = @mysql_query("SELECT * a .
tHUDUNU
FROM ‘referrals’ WHERE “id'='$id");
$update ref = @mysql query("UPDATE
‘referrals” SET 'hits'='$hits' WHERE milounu
\id‘=|$idr||);
Ad
Supdate cookie =
1 Management\fad\ctch
@mysql_query("UPDATE PR
refscr.php IMuauNu
‘ref_cookie'_list SET 'ip'='$ip' WHERE
id'=$id");
$insert_cookie = @mysql_query("INSERT
INTO “ref_cookic_list' (‘id","ip") VALUES Milpuy
(l$idr:|$ipl)rl);
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v d A A
- i ey NaanSINeMe
yolvla Mdanayelnd 3
AU Pixy
mysql_query("INSERT INTO blog SET
Blog\aoblogger\pppp “ o
title = '$title', message ='$message’, time = WMuauNU
p.php . _
'$time") or die(mysql_error());
Blog\blog\admin\add | mysql_query($createblog)or die("Could not =
tMuaUNU
article.php create blog");
Blog\blog\admin\add mysql_query($makeanswer) or P
IHUDUNU
choice.php die(mysqgl_error());
News
Publishing\aWebNew "
$result = mysql_query(Squery); WMUDUNU
s\aWebNews\feedbac
k.php
News u
$result = mysql_query($query); IMUBDUNY
Publishing\aWebNew
s\aWebNews\change i
$result12 = mysql_query($query12); IMHNDUNU
p-php
Blog\blog\admin\ban. | mysql query($insertip) or die("Could not 2
(MUDUNU
php insert ip");
News 4w
$result = mysql query($Squery); IMUDUNU
Publishing\aWebNew
s\aWebNews\ e
mysql_query($query); MUDUAY
post.php
$banner = @mysql query("SELECT * = 3
Advance\viewme.php MU UNU

FROM banners WHERE ‘id"='$id"");
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el
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maaniyesnd

o 4 A o
Haansiuamay

Ny Pixy

10

Advance'catchadd.ph

P

$banner_stat =
@mysql_fetch_array(@mysql query("SEL
ECT * FROM stats WHERE 'id"='$id"));

=) @
MUauUNu

$update_banner =
@mysgl_query("UPDATE stats SET
“hits™='$hits", ‘uni_hits’='$uni_hits’

WHERE id='$id"");

i<} s
MUDUNU

11

Advance\editme.php

$get_banner = @mysql_query("SELECT *
FROM banners WHERE “id'='$id");

| o
IMuBUNU

$update = @mysql query("UPDATE
banners SET ‘name’='$name' ,
‘mouseover ='$mouse_over',
"location’='$location’, "urlto’='$urlto’, stopit
"='$stopit','java_status'='$java_statusbar',’o

penin'='$openin' WHERE “id'='$id""):

& s
IMUDUNU

$update = @mysql query("UPDATE
banners SET 'name’'='$name' ,
‘mouseover ='$mouse over',
“urlto’='$urlto', stopit'='$stopit’, java_status
"='$java_statusbar',’openin’'='$openin'

WHERE "id'='$id"");

) o
IMuaunuy

$resultf = @mysql_query(Squeryf);

& a
IMyUauUnNu
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Iua

yolud

v
v

Ay i
AaINUY2)H7

v d A
HaansiNatnay

N Pixy

11

Advance'editme.php

Supdate = @mysql_query("UPDATE stats
SET

‘made’='$made’, file_location'='$location’,’

width'='$width', length'='$height', hits'='$

hits',"uni_hits'='$hits'," views'='$views', uni

_views'='$uni_views' WHERE “id"='$id"");

= at
HHuUaUNU

Supdate = @mysql_query("UPDATE stats
SET
‘made’='$made’," width'='$width', length' =
Sheight', hits'='Shits', uni_hits’='$hits', vie
ws ='$views', uni_views'='$uni_views'

WHERE "id"='$id");

Wipunu

$stat =
@mysql_fetch_array(@mysql query("SEL
ECT * FROM stats WHERE id='$id'"));

- r
IMuUBUNU

12

Advance\remove.php

$banner_info =
@mysql_fetch_array(@mysql query("SEL
ECT * FROM ‘banners’ WHERE
“id ='$delete™));

=] ar
HMuaUNU

$remove banner =
@mysql_query("DELETE FROM
“banners’ WHERE ‘id'='$delete™);

) ot
MUBUNU

$remove_stat = @mysql_query("DELETE
FROM ‘stats’ WHERE "id'='$delete');

=} s
MUDUNU
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; : At e NaaNSINBINaY
Ivlan ¥o'lvla Mdaniivealnd 3
U Pixy
Ad
13 Management\banner MySQL_Query($Query); Milouny
ad\banner_ad\ran.php
Ad ) Qs
$result = mysql_query($query); Myaunu
Management\banner
14
ad\banner_ad\ban_ins T
$result = mysql_query($query); MUBDUNU
tall.php
if($action==loeschen) {$loesche=mysql qu
ery("DELETE FROM Sad_table WHERE Milounu
ID=$ID");}
$stats=mysql_query("UPDATE $ad_table
SET IMPRESSIONS=0 WHERE milouny
ID=$ID");
$stats=mysql_query("UPDATE $ad_table . .
Ad milounu
SET KLICKS=0 WHERE ID=$ID");
Management\azbanne
15 if($action==partnernew){$new=mysql_que
r\admin\stats.php
ry("INSERT INTO $ad_table (ID, ART,
PARTNER, CODE, IMPRESSIONS) milouny
VALUES
(",1,'$BEZEICHNUNG','$CODE',0)");}
if($action==bannernew) {$new=mysql_quer
y("INSERT INTO $ad_table (ID, ART, = =
MuDUNU

BILD, URL, IMPRESSIONS, KLICKS)
VALUES (",0,’$BANNER','$URL',0,0)");}
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lad

Folud

U
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WNaansLNINay

1] Pixy

15

Ad
Management\azbanne

r\admin\stats.php

if($bannermodify::true){$aendernzmysql_
query("UPDATE $ad_table Set URL =
'SURL' WHERE ID = '$ID'");

= o
MusuUnNU

$aendern=mysql_query("UPDATE
$ad_table Set BILD = '$BILD' WHERE ID
s I$ID"I);

] [
IMuBUNU

if($pa?tnennodify==true) {$aendern=mysql
_query("UPDATE $ad_table Set
PARTNER ='SPARTNER' WHERE ID =
'$ID');

= o
IMyaUNY

$aendern=mysql_query("UPDATE
$ad_table Set CODE ='SCODE' WHERE
ID ="'$ID"™Y);

=) o
tHMuaUNU

$abfrage=mysql_query("SELECT * FROM
$ad_table WHERE ART=0 ORDER BY
ID");

= | ar
IMyauUNU

$abfrage=mysql query("SELECT * FROM
$ad_table WHERE ART=1 ORDER BY
ID");

=} s
MUaUNU

16

Affiliate
Programs\overstock

dfs\feeds \upload.php

$queryp2=mysql_query("LOAD DATA
LOCAL INFILE '$file' REPT.ACFE INTO
TABLE $table FIELDS TERMINATED
BY ' ENCLOSED BY "\"' LINES
TERMINATED BY "n' IGNORE 1
LINES");

A ar
tMuauUNU
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AU Pixy
Affiliate
$mysqglresult = mysql_query("update $table -
16 Programs\overstock IMUDUAU
set rndnumber=1000000*rand() ");
dfs\feeds \upload.php
$querypcatname=mysql query("Select * u
IMuaUNU
from categories where id='$_GET[cat]' ");
Affiliate $querypl=mysql_query("Select * from _—
MuauUnNu
17 Programs\overstock _ $table where category='$catslash' ");
dfs \category.php $queryp=mysql query("Select * from
$table where category='$catslash' limit mileuny
$start,$num_per_page");
Affiliate
18 Programs\overstock if (mysql_query($sql)) { wileunu
dfs \dbsetup.php
mysql_query("UPDATE sites SET
clicks="$row[1]', users='$udusers' WHERE Wilouny
id="Srow[0]"', $db)ordie(mysql_error());
$result = mysql_query(8$sql) or e
Click IMuauUNu
die(mysql_error());
19 Tracking\counter\cou
mysql_query("DELETE FROM sites . s
nter\counter.php MusuUnu
WHERE id=8id");
$result = mysql_query("SELECT id, clicks,
url, users FROM sites WHERE id=$id", MDA

$db) or die();
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mysql_query("UPDATE users SET pword
Classified Ads = md5('$newpass') WHERE email = Miouiu
\PHPRentals\phprent 'Suser');
. als\admin mysql_query("UPDATE users SET pword
\passwordchange.php = md5('$newpass') WHERE email = IMUDUAY
‘Suser™);

4.32 laammsiwenneiugudeyauuy PDO

g - s A AT Pu
Mrsuwansnaaeuny lwd PDO Wy Susanisieh 4.2

m31an 4.2 nfssuiisuwamsaunn Twd PDO vealilsunsuilandudy pixy

1 [l o
Jvlan ¥olwa PDO waansveallsunsuandu

HAaNSUR Pixy

$stmt = $db->query ("SELECT *

1 forum/index. php FROM table WHERE id=:id AND linuyoaIng
name=:name");
$result= $conn->query ("SELECT * B o .
2 platform/database.php Tunuaeslng
FROM idname WHERE 'id'='$id"");
static/storage-page- ' ] .
3 $result = $db_conn->query($query); Tiwnaealng

layout.php
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wamsnageuuasiFudioulumsieh 4.1 aql & lumsideudedugiudoya MysQL
g a . w o ° { o ' 1A @ J
Tsunsuianduuay Pixy 1iwadwsvesduiu dauas Taandludes Tniimilouny daunams
1] [ H ]
naaeylumei 4.2 a3l 189 Tsunsulanduammnsaaunumaes Tnives IMsfidowiouse

T Y
uuy PDO 14 luvaief Pixy ldausansieaeuIaadszinniild

4.4 ANUUANANIENIN Pixy sazTisunsuvesdivann

3 i " s ar " Y &l w r T
1) Pixy UdaaHan15aunuoonin)nyed 1na lagegimsuenussviaves Idanidluaes 1ud

Asi981911u31N 4.17 11 1 Ho9Tnanussian 7

4 A7 N\ . N\

Total Vuln Count: 0

FEERAEREERAER TN

XSS Analysis END

EAEREERAAENRREANSE

SQL Analysis BEGIN

TR TR

Number of sinks: 1

SQL Analysis Output

- C:\Users\WaramunLenovo\Desktop\check_login.php:7
Fod i~ 11

- unconditional

Total Vuln Count: 1

B el

SQL Analysis END

LR -

Total Time: 6 seconds

Ui 4.17 wheeuaaswamsainu IWaves Pixy
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2) llsunsuilandussuanswamsaunuiaz o Inl laouseussvianitos Ind wleura
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w3t msun Juveda Tnavy waz aunsoud luges Indvanua 1 lnesa Tussld

SobjQuery = mysql_query($strSQL);

SobjQuery = mysql_real_escape_string(SstrSQL);

¥ [
31 4.18 milhveuamsmansaunuAs T sunsulandu
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HNsunsulandumansaaunu Ildiiwendenugudoyauuy Ppo 18 ud Pixy I
annsom1d

r

Sresult = $db_conn->query(Squery);

asly Prepared Statements Tunisidlou . i
mnne Edit all azaunsaudlulsian: das SQL
Aszuan SELECT, INSERT, DELETE ‘Lsiasnsourile UPDATE s

BTN BETTW e raem

31 4.19 wiheeudaswansaunuTila PpO daeTUsunsuildndy
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4.5 anummsalumsilesiunmsloufuuy SQL Injection

M5199 4.3 nansnnumsaved Tsunsulandu lunsilea SQL jection Uszinn

A199

4 Y x
M350 4.3 agUanuansaves llsunsuldndu

U5217NUD9 SQL Injection asvaould

p—

Basic SQL Injection

(Escape Characters) v
2. Inline Comment I
3. Line Comment i
4. Union SQL Injections X

MWIZATURAINT 1Y Escape Characters
5. Blind SQL Injection

Comment 118% Inline Comment
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UNN 5

9/
unaUnazvetavanuy

5.1 unadwanmsauiivau

Tassondimi Idims i Tsunsinldnduuy NetBeans iag Eclipse 1t ¥ a1
Sunennanduiildniw pHP 111 umsasmaouuazudly IdafEusuaso dems Toud
521aM SQL Injection Tasludruvesmsasavaon It Idsunsy pixy dadlumioeiioluns
AR51¢ W 1A SUAT VUL static (static code anaylis tool) M1 T uuAUMED Wlourarinsiiy
auauldliaunsonstvaeyTdaiiinstoudoudesugmdoyauuy PDO (PHP Data Object)
18 dwmsuluduvesnmsuaawaiuensin Tsunsmasrmsuduion T8ai o Tni18ud
TsunswvziuzthTimandlaldmiiod1damsadon W T sunsuud 114188

=

3 = 1 c?
Taoanuaisoves sunsuyanduiiaeot

[
& 1

TA g @ "

- ansansaoyTaa PHP ien1v0a Iniiduduasioaonts Tou@uuy SQL Injection
ludnvuzma@oudendesugiudoyailszinn MysQL ien1s@uuiEoudarsy
31ud93a111 PDO (PHP Data Object)

F4 Y Aa 14 g o T = y . ¥

- annsoud lvIAan Yo Inaiiluduasisdon s Tandinuy SQL Injection 1111
MySQL 11ag PDO

- didudemded 19 (Help) e Tiduugihuazanudimud@nludinveanisesue sQL

— say o ) 4
Injection Uszinn wazisilosny SQL Injection

5.2 Yodnalumswmnn
- lugrsnvesmswan Tdsunsy Pixy luauisansaeaen I8an 181 PHP 71ilne S5y
1A PHP 4 1@
- lumsnadeuTisunsu pixy AoariimsFenldauniy cmd FeiinsBonldnufideutas
gaun
- ludawveanisi¥ouTdn PHP Foudeduguteya Pixy aw1saaunumvesIngld

o 4 1 1 a-ll
mmmm%mmmu MySQL itag PDO I(n1UY
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- ludupounisudlvife Tsunsy lawrsaudluids SQL 1/5¢1n UPDATE 1#i)u
Prepare Statements e

- Tsunsuliaunsoudlunis TouAves SQL Injection LUy Error Handing 1% Union 1§

- ldawsawmuuwyadialdafitaeadeld iesnnnisifou1da PP 1 daoase
aunsadouldvanvaty dFaialiaunsaadelfatmusandussuudeg 18

- ”13J'fmJ1'51-:1ﬁ'qﬁwmmﬁmwmmﬁ'ﬁnys"lﬁ’Lﬁmmnmmﬁmwamaaﬁaé’ﬂy'j suiludeq
ofunmed e APT Tun1sudnanauey NetBeans 1az Eclpse $3n158nu190 14207
wag MunMveuAsTLinaue 14

[ = =y 4 o o
- lwawrsaudadeu uaz Wadla msududon1d ifissninnsaunusidude 12 Wes

= ¥ 2 Y o qY¥Yu oY 0 Y A Y
l‘UEJ‘LIIﬂﬂlﬁimm’Zl“b’lﬂﬁﬂ%ﬁﬂ’lkthﬁ"llﬂiﬂﬂ’lﬂ']‘iLL"'lNl,FIﬂu]lﬂ
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5.3 Forauauuzlumsiannldsunsy
- masieldnsuldaunsoudly SQL Injection {11} Error Handing 41a% Union
- arsiaNuia e lanSefny1 Object-oriented Programming Vo111 sunsy' 18
8819790137
- A23%1015AAYI AP 489 NetBeans 1ay Eclipse 1 0i3 un 14 eidunsnaaina’ld
MamnvuaY

A CaY) = Gl 1 a @ (%
- N yuMTINYa0813 Iaauae PHP Adasasednudls

- USulgegduuumsiuaue Help Wiigtiuuiivhaulsnv@y wuvindu Flash

- oo lsunsu hissgndide 19 lumsasioaensea TnIuuY Cross Site Seripting
(XSS)

- annsath Tsunsu luWamnuy IDE §18191uen10 NetBeans 1a Eclipse &

- AwnsefnITuReu nszUNMTATIVEel TRAY Pixy iitori1 lszgnalFastvaey
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1) maﬂmu File > New Project... x‘igﬂ‘ﬁ .1

1 New Project... Ctrl+Shifte N ] Elf w B F'_b @
i 1 NewFile... CtrieN
(& OpenProject... Ctrl+Shift+ O

‘ Open Recent Project
Close Project (ProjectSqllnjection)
Open File...
Open Recent File
Project Gi » ¢

. m Learn & Disco
Project Properties (ProjectSqlinjection)
Import Project »
Export Project » Take a Tour
Save Ctrle§ Try a Sample Project
Save As.. What's New
Save All Ctri+ShiftS
Community Comner

Page Setup...
Prnt.., Ctrl+ Alts Shifts P
Printto HTML...

| e

T ok 6
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2) TunviAe New Project (39n Module LLﬁ"JﬂﬂﬂﬂJ Next
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i
L
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L]
I
€

¥
3

Java Web

Java EE
HTML/JavaScript
Java Card

Java ME

Maven

PP |
Groovy ‘
C/C++ ]
“1L NetBeans Modules i
@1}, Samples -
Dedfrioton:

Creates a new empty NetBeans Module.
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3.2) Hon Project Location #1714 2
v (]
3.3) A9%0 Project Folder @14 3

3.4) AdNADN Standalone Module 913 4
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Steps Name and Location

1. Choose Project Project Name: e

2. Name and Location Prmwll p 1
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ProjectFolder: |C:\Users\Sun\Deskiop ProjectSallnjection1 3

@ Standalone Module 4
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Module Suite: _ 4 ) o _ 007 () \ r v Erowse...
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4.4) nA1lu Finish Huduaiimsadiein/dnduny NetBeans
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| > NamemdL‘:cc:mn Code Name Base: orgsumiaramnpo ]
3. Basic Module (e.g. "org.yourorg,modulename”)
Configuration <
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[ Generate 05Gi Bunde
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Run
Debug
Profile
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Reload in Target Platform |

Install/Reload in DevelopmentIDE 2 muni

- & scanne|.

Create NBM

[ E layer.xi

@ ljg Important Files|
@l Lbraries 1
& @ ScannersQL |
@ gy SQU |
- &% TestTo

Generate Javadoc

Generate Architecture Description

Open Required Projects \
Close

Rename..,
Move...

Copy...
Delete

Delete

Find... Ctrl+F

Versioning 4
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1) Walisunsy NetBeans Yusudaudonuny Tools > Plugins Aan 107 1.6

Ef]@%'“)@'- __ T dores.

Internationalization

|| Projects X |Files | Services f
|| @& JavaAppication1 Java Platforms
E *_MI i NetBeans Platforms
B +

[;E; ﬁLf\ mﬁ;;xﬁ Ant Variables

| B g Libraries

|| - Projectsqlinjection Templates

' DTDs and XML Schemas

Libraries

314 n.6 miveideniuy Tools > Plugins 11 NetBeans
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2) VUNTIAN Plugins 139N Downloaded > Add Plugins... nnuuden amesvos

Tisunsu mwA2e build > org-sunwaramun-projectsqlinjection.nbm

0 1 Plugins ﬂ
| Updaes 15| Avsabe hges (164 [Dorriosded (1) | ntaed (37  Settngs R
| 2 |

kL e
1 |
i : o 1. classes |
| St L. classes-generated
[ |8 Rec:;‘{m 1. cluster on.nbm
B 1. depcache
il 1. public-package-jars
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| ;
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g‘ﬂﬁ 1.7 HUA19MTAeN org-sunwaramun-projectsqlinjection.nbm



3) 1110 Add Plugins u&11¥ndniden ProjectSqlinjection udna1ju Install AININA .8

 Undates (14 | Avalable Pogns 164)| Dowrladed (1) | Instaled (37 Settngs

Source: org-sunwaramun-projectsginjection,nbm

| e, | A
L 1
:“"""El mlllﬁ ProjectSqlinjection [ Remore ] |
{# Community Contributed Plugin
Version: 1.0
, Date: 5/19/71

Y

70 0.8 wihanmM3den ProjectSqllnjection
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4) ilerdhg 1A Install 1nATju Next

9] Plugins ' ﬂ

31N 0.9 1111619 Install
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5) MINUuAdNEeN “I accept the terms in all of the license agreements” L!ﬁ".]ﬂﬂﬂn Install
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with the particular plugins,

| Plugins: |ProjectSqllnjection [1.0]
INO LICENSE SPECIFIED]
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; - 2 . 3
6) 1o Tsunsudnaaissudoondrazinea1a81an1¥na Finish

Installation completed successfully
Click Finish to quit the NetBeans IDE installer,

The NetBeans IDE Installer has successfully installed the following plugins:
ProjectSqllnjection

" v
310 2.1 wieaueansiad AU Install
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[+ Ljg Important Files
[# b Libraries
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Add to Favorites

Help

Analyze Javadoc

Internationalization »
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Ant Variables

Libraries
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DTDs and XML Schemas ’
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| Options
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.1 35519l sunsuanduun Eclipse

1) LﬁﬂﬂlﬂJH File > New > Other... ﬁﬁgﬂﬁ .1

TRl

LFile] Edit _Source Refactor Navigate Search Project Run Window Help

| New Alt+Shift+N » § 1¥  Plug-in Project r
[ OpenFile.. ] (g  Feature Project
s . i
l Close Ctrew | [ Project.. :
' Close All Ctrl+Shift+W | L Component Definition D
Sl Ctrl5 ? Product Configuration 2
‘ B SaveAs.. i8] Target Definition L.
r
[ Save Al Cirieshiftes | &5 Package -
i ) & Class
| & Interface 3
| yioye... @7 Source Folder
j * | Rename.. F2 [% File
; 2] Refresh F5 (8 Folder -
| Convert Line Delimiters To »
! [ 9 Example... 2
Print.. Ctrl+P
‘ 5 other.. CtieN
‘ Switch Workspace » PARND st
| Restart "“\n"+
| "\n\b\t Tum
|3 Import., ; ':n:: wanlum
| "\n\b ieu s
|3 Export.. "\n\b neestoer
‘ 5 3 “\n\b Squer
? Properties Alt+Enter 1 "\m\b\t (\"
1 ULjava [UIPRO/rc] I ::m: ‘_:
2 sitexml [sdfa] 4 "\n\b\t mys
3 featurexm [sdf] y \mibt . "+
| AMANFESTMF [so/META-INF| burce| [ Design|
‘ Exit

31 2.1 viheeuaasmsi@oniy File > New > Other. .



2) 1Hen Plug-in Project (13INA Next

Selecta wizard ‘,\‘}
Create a Plug-in Project r
Wizards:
[ypefertet ]
4 (=% Plug-in Development -

=" Category Definition

a Component Definition

4 Extension Point Schema =
4 Feature Patch

[j% Feature Project =
=5« Fragment Project

% Plug-in from Existing JAR Archives

il Product Configuration
‘@ Target Definition

&~ Update Site Project -
9 )
F=
@ < Back : & m >4 : Finish [
- ————— =

=l o A . s
JU 2.2 mieanansnsiden Plug-in Project
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3) @3A1 Plug-in Project Llﬁ,’)ﬂﬂﬂn Next > ﬂﬁgﬂﬁ V.3

'. N‘ewPIug-rin Prqect oject |

Plug-in Project )
Create a new plug-in project y

Project name: SQLInjectionScanner

Use default location

Location: | C:‘-;kt!scrs\.Sun‘:woricSp;ceNm‘xSQLInjectiunScanner

Browse...

Project Settings

(/| Create a Java project
Sourcefolder: src

Output folder: bm

Target Platform
This plug-in is targeted to run with:

@ Eclipse version; 3.5 orgreater v

(") an 0SGi framework: fEc;m-léx '%

Working sets
["] Add project to working sets

-.y‘y‘.:;;l’ln."; sets: | v Select...

| @ el e | e

1 v 1
31 v.3 mil1e19UaRIN1TA9UD Plug-in Project
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4) NALN Next > DAY

& New Plug-in Project

Content
Enter the data required to generate the plug-in,

Properties

1 SQi.InJectlonScanner

Version: 1.0.0. quahfler

Name: SQHnjedlonScanner

Vendor:

Execution Environment: |JavaSE-1.7

Options

Activator: sqlmjectlonscanner.Actnrator
[¥] This plug-in will make contributions to the Ul
[”| Enable API analysis

Rich Client Application
Would you like to create a 3.x rich client application?

[V] Generate an activator, a Java class that controls the plug-in's life cycle

('Yes @ No

,<B$d:

Ia Next >= [a)

9

Fini

o Cancel

Y

T 9
31 v.4 mifieauanIn1A9e Plug-in Project
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5) hen Hello, World Command (1877 Finish ﬁ&gﬂﬁ 9.5

- e ———————————
& New Plug-in pww 7

Templates
Select one of the available templates to generate a fully-functioning plug-in.

Create a plug-in using one of the templates

Available Templates:

%" Custom plug-in wizard
<% Hello, World

¥ Hello, World Command

47 Plug-in with a multi-page editor

9% Plug-in with a popup menu

5 Plug-in with a property page

9 Plug-in with a view

4% Plug-in with an editor

97 Plug-in with an incremental project build
7 Plug-in with sample help content

< I

o = ) \ By

|
|
|
i{
I
i
|
{
I
|
|
|

:Tﬁis wizard creates standard plug-in

directory structure and adds the following:

'® Command contribution. This template
creates a simple command contribution

that adds Sample Menu to the menu bar |

and a button to the tool bar. Both the
menu item in the new menu and the
button invoke the same Sample Action,
Its role is to open a simple message
dialog with a message of your choice.

|Extensions Used

® org.eclipse.ui.commands
org.eclipse.ui.handlers

'® org.eclipse.ui.bindings

® org.eclipse.ui.menus

@ [ <Back ]|

Next > ]

Finish || cancel |

g‘ﬂ‘ﬁ 4.5 niheauaadon Templates Plug-in Project
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bdder

1§ PackageExplorer 57 = flgn: = [

b '15 org.eclipse.core.resources
» 1 org.eclipse.core.resources.win32.486_64
2 59
4 1= SQUinjectionScanner
B JRE System Library [JavaSE-17]
I B Plug-in Dependencies
> (8 sre
(= icons
4 (= META-INF
4 MANIFEST MF
[,ﬁ build.properties
& pluginaml
e
U

12 UIPRO

File Edit Navigate Search Project Run Window Help
N D R e T

4 SQUinjectionScanner 57
4 Overview

General Information
This seclion describes general information about this plug-in.

ID: SOUinjectionScanner
Version: 1.0.0.qualifier —

Name: 5QLInjectionScanner Ty

Vendor, [7/ )

Platform Filter: - R

Activater: sqlinjecﬁor;szlnnuAdivator \

[ 7] Activate this plug-in when one of its classes is loaded
[VI This plug-in is a singleton

Execution Environments
Specify the minimum execution environments required to run this plug-in,
B JavaSE-17 Add...
Remove
~
Dow n_‘

Th

To
1

[ OVENI!W‘DEPEﬂdenCIQSRUMIM;,EX‘IEHSIOH;F Extension Points| Buiild'l«.Th‘kl’\IIF'ESTT.MF‘|:I.ugin.xr|7'1l.i

U7 4.6 e Talsunsy SQLInjectionScanner
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v.2 35031962 AAAY (Install) vesTi)sunsualdnduuu Eclipse

Tunoulumsa§19d3 Install veaTsunsuanduuy Eclipse

1) Aaanunlysien SQLInjectionScanner uduAen New > Other... ﬁdgﬂﬁ .7

- Plug-in Develo e - . 2
File Edit Source Refactor Navigate Search Project Run Window Help
e I SR U1 0 KA SR e s e M ke e s
I8 Pack.. 2 |&Pg. = O pleHandle ) i [3) Activatorjava 52
_—? \:., = ke sals s - ._____; - —
I+ 4= org.eclipse.core.resourc 4 e ._I 54 Plug-in pmfm
» i3 org.eclipse.core.resources Golnto 1 K" Feature Project
n X | ad 2
12 sl . | QOpen in New Window 2 Project..
i SQlnjectionScanner . . 5
o ssq Show In Alt+Shift+W » | o  Component Definition
&
A0 @ Copy Cilsc | B Product Configuration
1=} UIPRO B oot uliei Neme &/ Target Definition
| Paste ety | B z :""“
| % Delete Delete @ g
! @ Interface
I Build Path » &9 Source Folder
Refactor Alt+Shift+T» | File
‘.‘g Import... (3 Folder
'ﬁ Export...
i & Refresh FS
Close Project i.framework.BundleContext)
| Close Unrelated Proj
‘ Assign Worki gs:’:ds ext context) throws Exception {
sign in| =
Validate
| Debug As »
Run As i
Team » n.Abstrc:tUIPlugin:;tcplc'g.csgi.f'arrem)rk.Bundletcntgxt)
‘ Compare With »
i‘ Restore from Local History...
| Plug-in Tools » hl ) o
oy F— yo— | e . es\Java\jre7\bin\javaw.exe (2 A u. 2557, 16:10:31)
SQLInjectionScanner Properties Alt+Enter

31U 4.7 nirveuanimsideniuy File > New > Other...
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2) 1800 Feature Project 18InA Next

e
Select a wizard — >
Create a Feature project f
Wizards:
[oypefitertee ]
' 4 (= Plug-in Development -
=" Category Definition
ll 2] Component Definition

E}‘ Extension Point Schema

| 4 Feature Patch
" 1
- Fragment Project

b (% Plug-in from Existing JAR Archives
3% Plug-in Project

1 g Product Configuration

‘@ Target Definition

&~ Update Site Project -
i

| 2

TS (SR

NI T S 4

31 v.8 wildatanIn151A0n Feature Project



Feature Properties d] N
Define properties that will be placed in the feature.xm file '

Project name: SQLInjectionScanmnerFeature

Use default location

Location: | C Usgrs‘5””‘W°fk5PﬂCENEW‘éQLanedmnScannerFeature | [ Browse.
Feature properties

Fastave J° SQU".IEctrlrt;r;S‘canﬁerF-eaEl: &k N\ .
Feature Name: _SQLI.njeca;;s’,g;Hﬁe,ﬁét;; U<t %\
Feature Version: R O MGRY” / A | P e s Bl T W
Feature Vendor: ~1 (. Q\ O X I Tt R o+ "

Install Handler Library:

® s —_-

9 1] é’;

Ui 4.9 nihA1aaAINITA9Y0 Project name

[T
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4) AdnIADN SQLInjectionScanner (1.0.0.qualifier) &N Finish

Referenced Plug-ins and Fragments
Select the plug-ins and fragments from your workspace to package into the

new feature,

() Initialize from a launch configuration: | Fclipse Applicétmn

© Initialize from the plug-ins list:

[7] %= org.eclipse.wstxml.ui (1.1.401.v201308132110) -
[7] %= org.hamcrest.core (1.3.0./201303031735)
[] % org.hamcrest.core.source (1.3.0.v201303031735)
["] %= org.junit (4.11.0.v+201303080030)
h 3% org.junit.source (4.11.0.v201303080030)

%> org.objectweb.asm (3.31.v201105211655) Deselect

| [7] %> org.objectweb.asm.source (3.3.1.v201105211655)
[7] %= org.satdj.core (2.3.51201308161310)

[7] %= org.satdj.pb (2.3.5.v201308161310)

7] %= orgw3c.css.sac (1.3.1.v200903091627)
(7] %= org.w3c.dom.smil (1.0.0.v200806040011)

7] %~ orga3c.dom.svg (11.0v201011041433) E
[ 717 %" Squnjectionscanner (L00.qualifien | 1 S
' 4 L"_ e g g m RS~ R LY Ll.i ’

1 of 500 selected,

gﬂﬁ 2.10 Hfl"lﬁhﬁuﬁﬂﬂmﬂﬁﬂﬂ SQLInjectionScanner (1.0.0.qualifier)
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5) aAanyh SQLInjectionScanner Ld94300 New > Other. ..

B og i DR Lt - . ;
File Edit Source Refactor Navigate Search Project Run Window Help
LB RO G e 2 0 Wil oA fl i 1 8 3+ r i e

4 Pack.. 2 EPug. = 0O

andlerjay ¢ ] 3] Activatorjava 52
TSI T 0 s —— —

n = T PSS
b5 o:g.cclipse.cor:.r:eu:ﬂl— New _']' %3 Plug-in Project
I3 org.eclipse.core.resources Golnto 2 | 4% Feature Project
T | Open in New Window 3 et
| Showin AltsShiftsW » | 5]  Component Definition
2u 1 B Copy e E’ Product Configuaton
i i Copy Qualfied Nome ol Tagent
B Paste Ciiey | B Package
[ % Delete Delete | & Class
| & Interface
| Build Path WS Soucasolosé
Refactor Alt+Shift+T » 5 File
\f2g Import.. [ Folder
|1 Export.. Y Eample. 3
| & Refresh
| Close Project
| Close Unrelated Projects
| Assign Working Sets... ext context) throws Exception {
Validate
| Debug As »
| Run As »
Team b In.AbstractUIPluginkstop(org.osgi. framework.BundleContext)
{ Compare With »
| Restore from Local History..
Plug-in Tools ] T |
i — - S ) ples\avajreT\bin\javaw.exe (2 f.0. 2557, 16:10:31) L
SQUInjectionScanner Properties Alt+Enter

31 v.11 wihaenisiien New > Other. ..
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6) Tunii1619 New 1800 Update Site Project 114900 Next >

Select a wizard -_¢
Create an Update Site project r
- —
Wizards:
| typefiltertet

47 Extension Point Schema

& Feature Patch

14 Feature Project

«5 Fragment Project

% Plug-in from Existing JAR Archives
- i3 Plug-in Project
' g Product Configuration
l ‘& Target Definition
=¥ Upda f i
b [ User Assistance

4 (= WindowBuilder

[%] Project Palette

314 v.12 miea New tiamenisidon Update Site Project
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¥
s

7) Aa%0 Project name A SQLInjectionScannerUpdate uﬁ”mﬂﬂu Finish ﬁdgﬂﬁ .7

@ i

Update Site Project
I Create a new update site project
1
Project name: SQLInjectionScannerUpdate]
! i
\ Use default location |
i Location: | C:.\.Users‘\S;ﬁ:‘iﬁ;rkipa-c-gﬂgvy\‘sgLIp_je_c_tiqn%can_nerr”l‘J“pda:e__" 1 B Browse... i
|

Web Resources
["] Generate a web page listing all available features within the site

Web resatirces location: | web

¥
(Y

31 9.13 mH1A19n157@3%0 Project name
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8) 1010 site.xml HAINALY Add Feature #1331/ v.8

le Edit Navigate Search Project Run Window Help

{8 Pack.. §3 =1 = O [l SampleHandlerjava (i) Helpjava  [1) Activatorjava (5. SQUinjectionScannerFeature [3) siteaml 53
=% 7 g Update Site Ma

12 org.eclipse.core.resources R il P
I l? org.eclipse.core.resources.win

Fi

& A Managing the Site

| B SQ&M{OE'"W’F 1. Add the features to be published on the site.

* & SQUinjectionScannerfeature 2. For easier browsing of the site, categorize the features by dragging.

4 12 SQLInjectionScannerUpdate 3. Build the features,

h 1

o New Category
g3 U
P e 2 |l AddFeature..

Synchronize..

Build

Eul:lal

| SteMap|Archives | siteami| "Hh ~

U v.14 wiheouanInIs Add Feature
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9) Tund19 Feature Selection 1ADN SQLInjectionScannerFeature (1.0.0 qualifier) I,Li;%ﬂﬂﬂu

OK

Select a feature: v

-fQLlnje—c-tionScanner
Matching items:
{@SQUnjedionScannerFeature (1.0.0.qualifier) !l

II! '

! org.eclipse.pde.intemal.core.fcafure.WorkspaceFeatureModd@IQaBOSﬂ }

gﬂﬁ V.15 ﬂlT’lFi”N Feature Selection
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10) Tumileang Update Site Map Hon SQLInjectionScannerFeature (1.0.0 qualifier) 1aan ﬂﬁll
Build All

w adie: il
n Window Help

L O I, ST e

Search Project Ru

= 0[] sampleHandlerjova  [J] Helpjava  [i] Activatorjava  Z: SQUInjectionScannerl
8% v & Update Site Map

b 4= org.eclipse.core.resources

ST g st
-t o 1. Add the features to be published on the site,
» & SQinjectionScannerFeature 2. For easier browsing of the site, categorize the features by dragging,

4 & SQUinjectionScannerlpdate | 3 Byild the features.
) sitexml e —
b 5 ssq I'_‘-q; SQLInjectionScannerFeature (1.0.0.qualifier) | New Category
b Ul 1
» & UPRO i Add Feature..

chronize..

2 || . Buildan

Site Map | Archives | sitexml 1

31U v.16 miveuaRINT Build All
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kY
@

11) ionaifu Build All udaes IdMaRadadnaudiu Ing jar

Managing the Site
1. Add the features to be published on the site.

2. For easier browsing of the site, categorize the features by dragging.
3. Build the features.

New [}

Add Feature...
Synchronize...

Build

Build All

el

L1 S AN — S ERNAY. S

Site Map r A—rchives : sitexml |

.d' Y o a & g a o3 d
3N v.17 niheeuaasiidasalanduilulng jar
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.3 M3faaaldsunsualdnduum Eclipse

v ¥ o 3/
YUADUMIAAAT [ 5UnTUUANBUAILN Eclipse H3TmIeal

1) MnEaeved Eclipse Lﬁﬂﬂmiﬁl Help > Install New Software. ..

Fh!dtSoumeRdmemngurd!PmRunWmdow
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31U .18

I‘ e X B0~ Q":E?G":q [
f8 Pack.. 52 $Phg . of O Mo Contunt 3
= @7 Search
= & [~y 2
& Update Site Ma Hi
12 org.eclipse.core.resources v " 3 Tpaiabii
I+ Iz org.eclipse.core.resources.win - the Siie. \ Key Assist... Ctrl+ Shift+L
» i SQUnjectionScanner 1. Add the features to be publishe.  Tips and Tricks,.
1 SQUnjectionScannerfeature 2, For easier browsing of the site, | Cheat Sheets...
4 | SQUinjectionScannerUpdate 3, Build the features, |
(&> features i Eclipse Marketplace...
= . ‘41 feuu;eslSQL]n'minnScn‘
e phugles: : Check for Updates Z 3
(., artifacts,jar
., contentjar Install New Software...
¥ sitexm| I About Eclipse
& 159 [
e o)
1
&2 UIPRO

& Welcome

Site Map| Archives| sitexml|

31U 0.18 MI1900aAINS Install New Software

@ sitexml 53

Feature Properties
Properties for the selected fi

URL": | features/SQLInjectic
[7] This feature is a patch for

Feature Environments
Specify the environments in
Leave blank if the feature dc
Operating Systems:

Window Systems:

Languages:

Architecture:
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2) Tunvi1Ae Install w94 Eclipse natjy Add

I Available Software
Select a site or enter the location of a site, (
Workwith: tpeorselectaste E————— -—m=
! Find more software by working with the ZAvailable Software Sites” preferences.
[typefitertet - B n B e -
: ‘ Name ’ ' - Vesion - ]
- [1@ Thereis no site selected.
| |
| |
[ selectan | [ Deselectan {
Details
- [¥] Show only the latest versions of available software [7] Hide items that are already installed
[¥] Group items by category What is already installed?
[71Show enly scftware applicable to target environment
| [¥] Contact all update sites during install to find required software

3UN .19 nha1ems Install
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3) luntha1e Add Repository ﬂﬂﬂu Archive...

@ Add Repository

Name: SQLInjectionScanner Local...

Location: http://

gﬂﬁ V20111919 Add Repository

b { 4 & a '
4) v T Iawmesves Tsunsuldndu den content jar 1§I0A) Open

e Repos:toryatﬂ\i_\ggf : s 2
m’—'ﬂ Lo« workspaceNew 3 SQunjectronSHnnuUpdate 3 - m Searcn SQLr"Je’rim"SCGF’V‘CVU,’J ,Ol
e R, (B ————— S UP N Jau s o e TN i :
Organrze v  Newfolder o @
ek —=4 3 7 TISRRTRIN AN 4 AL f02coC9CR 8 L BB T
3 Favexites 1!] Name Datemodrﬂed Type
Bl Desktop 4 features 2/6/2557 16:33 File folder
# Downloads { . plugins 1 2/6/2557 16:33 File folder
%% Dropbox | ] artifacts,jar 2/6/255716:33 Executable Jar File
| Recent Places j | 2/6/2557 16:33 / Executable Jar File
i ~ Libraries %
3 & Apps L
' |'¥| Documents
: &' Music
h =/ Pictures
r B videos
| o Homegroup v 4 m | ¢
|
_" File name: content,jar [ Jjar*.zip

31 w21 mhsuanansidion content jar
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1 H Fa
5) evi1do 4) udr9znduinfiniiieng Add Repository B natlu OK

¢ € Add Repository

Neme:  SQUnjectonscanner
Location: jarfile/Ci/Users/Sun/workspaceNiew/SQLinjectionScanne

g‘llﬁ v.22 ¥ithA19 Add Repository

6) NAVYIANTNA Install GRLIGRN Uncategorized 11a¥ SQLInjectionScannerFeature 1A%

AALN Next > fag1/i ¥.23

B o & ool £ b e e D AT ¢ A 4 ke L 00 W
| Available Software
Check the items that you wish to install, ”
Workwith:  SQUinjectionScanner - j..—:hlé:cw:«s/sun;woﬂupmm-\{/sqmjecﬁons:anrfeﬂpd.:e.f:bn:mf’.,‘aﬂf 4 7
ﬁndmmﬂw-nbym&hgwimmemw preferences,
Elypeflhf.‘L!;t = . ' g% % i j 77 7 & '\ J iy y |
Name | ) Version
N [4]000 Uncategonzed
[#] §* SQUnjectionScannerFeature | 1 1.0.0.255706021633

[ selectau H_Desduthll“] litnfsdncud

Details
[#] Show only the latest versions of available software (V] Hide items that are already installed
[¥] Group items by category What is already installed?

(7] Show only software applicable to target envi

l [¥] Contact all update sites during install to find required software

gﬂﬁ .23 M11A14 Install uaaudon SQLInjectionScannerFeature



1 g r {
7) ARy Next > Bnnsedegalil v.24

Install Details
Review the items to be installed.

1 hilme . N - i Version
| @ sQUinjectionScannerFeature 1.0.0.255706021633
|

Size: Unknown
Details

SQUInjectionScannerFeature featur...

31N v.24 wilAeuanIns Install
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¥ '
8) MNTUADUN 7) Adnden “1 accept the term of the license agreement” 1820A Finish

| Review Licenses f
Licenses must be reviewed and accepted before the software can be installed,

License text (for SQUinjectionScannerFeature 1,0.0.255706021633):
[Enter License Description here.]

1

@ laccept the terms of the license agreement
not accept the terms e license lgru}n!nt

B | PN S, , T Py F !

® (i) v |[Cram T e ] |

31 v.25 wihsuaasmssousutonnas
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s - 5 ~ 1 3
9) wasndansFouTesudiesiiniieg Software Update 313 1% Restart Eclipse 1¥ine
ij:u Yes

K Scfiware Updates

You will need to restart Eclipse for the changes to take effect, Would you like to
restart now?

gﬂﬁ .26 1111161149 Restart Eclipse

T Fa o
10) 13J0 Restart Eclipse nda91n@asa T1lsunsuildnsuuda M TUsunTuIZRgULILY Tools

T @
3U v.27 wilwoudasmyvosllsunsnldnduny Eclipse





